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GETTING STARTED CHECKLIST (THE BASICS)

The checklist below is provided to help you get started with SFX (Secure File Exchange).
Tasks are listed in the order in which they are typically performed.

|

TASK

¥
o

Review User Roles

Review how to navigate in SFX

Review the video, "Where are the Menu Options"

Create Folders

Add Files

Update an Existing File

Submit Draft for approval (if necessary)

Set up Alerts

Set up Favorites

Modify Access to your Folders or Files (if necessary)

Check files out / in (to edit as necessary)

Approve Drafts (if you are an approver)

Administer the Repository (add users, access rights, etc)

()| | ) )

(This is not a comprehensive list of everything you can do... just a list to help get you
started with Secured File Exchange)






How Do | NAVIGATE IN S FX

@ Note: Your navigation options can be limited by your assigned roles. If you do
not see an option or a screen element described in this user guide, then you do
not have the required role.

The following screen shot illustrates common SFX window elements.

Secure File Exchange

STATUS  SIZE

(5] christ23 Folder == 8

Navigate to a file by searching for it, or by drilling down into the folder structure.

To drill down into the folder structure:

1. Click a folder from the Home Page. The folder contents display.

Secure File Exchange

Folder Actions | Admin | Help | View: Al Documents Z|

HOME |Search Documents E'
NAME STATUS SIZE TYPE MODIFIEDDATE -  LINK
April 13, 2011 12:49
Mike Test 1 Folder == 8
PM EDT
April 11, 2011 11:50
[55] Cov Q& - April11 Folder == 8

March 23, 2011 D4:43
[Z5] Testing PUP-2168 Folder == 8
PM EDT
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2. Select subfolders as required.

Secure File Exchange

Folder Actions | Admin | Help View: Al Documents E|

HOME > MIKE TEST 1 ‘Search Documents [a]

STATHIS  BIZE TYPE MODIFIED DATE

April 13, 2011 01:23
Folder = o
FI EDT

3. Click the file you want to view.

Secure File Exchange

YRR T—
4]

Folder Actions  Admin  Help |

HOME > MIKETEST1 > MIKE TESTA |Search Documents

TYPE MODIFIED DATE

April 13, 2011 01:23

[ GAPTIVATE mousecicik.gif DI 23KB  gif = 8
= PM EDT
April 12, 2011 01:23
|@ Wy Groups Test 2.xis FIEEH q 18KB  .xls &3 a
PM EDT

4. You can quickly navigate to the Home page or a folder within the current path by
clicking the items in the navigation path, as shown below.

Secure File Exchange

=ws Al Decumentz Z|

earch Documents @

STATUS SIZE TYPE MODIFIED DATE

D CAFTIVATE_mousedcik.gif EI=EEH F 4 -

April 12,2011 01:23
FM EDT

April 13, 2011 01:23

@ My Groups Test 2.xls [
PM EDT

= &




How Do | Navigate in SFX?






WHERE ARE THE MENU OPTIONS? WATCH HOW TO

FIND THE MENU OPTIONS >>

Most menu options are displayed by clicking the drop-down arrow located at the far right
of the item.

The following sequence of screen shots illustrates item-related menu options.

e Anitem's menu options are not always visible.

Secure File Exchange

Folder Actions | Admin | Help | View: AlDocuments ¥

HOME > MIKE TEST1 > MIKE TEST A ‘Search Documents [a]

NAME STATUS SIZE TYPE MODIFIED DATE LINK
April 13, 2011 01:23

[) CAPTIVATE mousedicik gif [ 438 gif e 2
PM EOT
April 13,2011 01:22

) My Groups Test 2xis I 18KB  xls s B
FM EDT

e When you hover the cursor over an item, its menu selection drop-down arrow
displays.

Secure File Exchange

=t 3= -ll'.ﬂ'l-'ll-ll'lli-llﬁ
Folder Actions Admin Help View: All Documents Z|

Search Documents @
STATUS SIZE TYPE MODIFIED DATE
April 13, 2011 01:23 = g

HOME > MIKE TEST1 > MIKE TEST A

|D CAPTIVATE_ mousedcik gif 43KB  gif
PMEDT
April 13, 2011 01:23
) My Groups Test 215 1BKB s s 2
PMEDT

e Clicking the arrow displays the initial list of menu options.
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The initial option list
displays. ltems such as
Workflow have submenus.

iew: Al Documents

Folder Actions Admin Help
HOME > MIKE TEST1 > MIKE TEST A
f

O /0 &

& ®

Cut

Cup-,,{h

Download

Delete
Workflow I
Favorites & Alekts

Reports 3

View Properties

Edit Properties

e Some menu options have submenus.

"Search Documents

April 13, 2011 01:23
PM EDT

April 13, 2011 01:23

PM EDT

Folder Actions Admin Help

(%]
T
1]
1
1
1
m
I:
C
i
i
[
=]

O &)

&)
2

Download

Delete
Workflow 2
Favorites & Alekts

Reports 2

View Properties

Edit Properties

E_j Check out {L"]

View: Al Documents

Search Docurments

April 13, 2011 01:23

PM EDT

2011 01:22

April 13,

PM EDT

e

(2]




USER ROLES

Assigning Users to Roles in SFX Repository

@ This task can only be performed by an SFX Administrator.

Caution: Changes made to the Repository Settings impact everything
from the top-level Home folder down. For example, if you add a user or
group to the Administrator role, that user or group becomes an
Administrator for the entire SFX instance.

1. From the Admin menu, click Repository Settings.

Where is the option?

Secure File Exchange [ >

Wiew: Al Documents

|Search Documents

_ Reports b STATUS  SIZE TYPE MODIFIED DATE

) March 11, 2011 03:46
[E5) chris123 Folder &3
AMEST

2. Click next to Add Members in the role type to which you wish to add users.
The User Directory window displays.
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10

Secure File Exchange

Folder Actions Admin Help View: ANl Documents

Access Lavel Add ADMIN Members

n ADMIN:

ﬁ Add Members

M@ Financial

m COORDINATOR:

ﬁ Add Members

'ﬂ Tester Two

m COLLABORATOR:

@ Add Members

m CONTRIBUTOR:

'@ Add Membaers

M Tester Four

ﬂ VIEWER:
'@ Add Mambers

M sServices for EVERYONE |

r Require approval

¥ Follaw file retantion palicy
Duration (in days) :

I Enforce axpiry within retention

Ok CANCEL

3. Search for and Select the people you want to add to the role for which you clicked
Add Members.



User Roles

User Directory

Type in name Include

[test Jusers =l
HName Type Organization -

¥ Tester Fowr User

T Tester One User
F Taster Thraa Usar s
[T Tester Twe Usar
[~ Tester, Q& User _d

Selected People
@ Tester Four {0 Tester Three

“ Cancel

a. Type the name (or partial name) of the user or group in the Type in name
field.
b. If you want to restrict your search to individual users, click the Include
drop-down arrow and select Users.
c. Click Find. The screen refreshes, and the search results display.
d. Select the check box of each user or group you want to add to the selected
SFX role. Checked users display in the Selected People list.
e. Click OK. The User Directory window closes and the users you added
display in the appropriate role section under REPOSITORY
CONFIGURATION SETTINGS.
4. Repeat steps 2 and 3 for each role to which you want to add users.
5. Click OK. The SFX HOME page displays in your portal.

RESULT:

You have successfully added users to roles in SFX

11
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Removing Users and Groups from Roles in SFX Repository

@ This task can only be performed by an SFX Administrator.

Caution: Removing Users and Groups at the repository level restricts
them from accessing anything within SFX.

If you want to remove users or groups from particular files or folders, do
not perform this procedure. Instead, modify access rights to the item.

1. From the Admin menu, click Repository Settings. The Repository Configuration
Settings window displays.

Where is the option?

Secure File Exchange | .
View: Al Documents

HOME ‘Search Documents
_ s b

i March 11, 2011 03:48
[E5] chris122 Folder &9

AM EST

2. Click the wastebasketicon T next to the name of each user or group you want to
remove.

12



User Roles

Secure File Exchange

Folder Actions Admin Help

View: Al Documents

HOME

I,-Q REPOSITORY CONFIGURATION SETTING S
Access Level
n ADMIN:

@ Add Mambers

M relerndu ; Soartt ;T 3wl ey Crike

T ricasialy, Foan . [ Slo pebor; Tostor S

COORDINATOR:

@ Add Member

Click to delete

'@ er Twa

m COLLABORATOR:

@ Add Members

'@ Dee

[l Tester Three

E CONTRIBUTOR:

@ Add Members

il vie [l Tester Four

ﬂ VIEWER:

@ Add Members

flif Portal: Services for EVERYCOME

M St 10 ¥ aSthrl § AR W ls il Wb TR el 11§ a2l 1P Pl | afbe] ¥ Ity % Ll % | S 1

(| Require approval

¥ Fallow file retention policy

Duration (in days) :
rl

I_EnF-:-n:e expiry within retention

OK

CANCEL

3. Click OK.

RESULT:

13
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You have successfully removed users from roles in SFX.

14



User Roles

Role Definitions

Access to folders and documents is controlled with user roles. Users can have one or
more of the roles listed below. Users can have different roles pertaining to different
folders or documents. In other words, a user with the Viewer role on folder A, could
have the Collaborator role on folder B.

SFX Role Summary

Role Title Role Capabilities
M viewer Viewers can view and download files and folders.
B contrIBUTOR Contributors can view, download, and create files and folders, in

addition to performing Owner tasks on their files and folders.
B! coutaeorator  Collaborators can view, download, create, and update files and
L folders.

& coorpinator  Coordinators can view, download, create, update, and delete files
and folders. They can also edit file and folder properties and
manage access to files and folders.

£l apmIn Administrators can perform a wide range of tasks, such as:

e View, download, create, update, and delete all files and
folders

e Change file and folder ownership

e Assign folder fax numbers

o Configure global approval and rejection settings

o Configure repository settings

°5(Owner) Owner is not an assignable role like the roles listed above. If you

see the & owner icon displayed to the right of a file or folder
item, it indicates you have the Owner role for the item and you
can control user access, delete the file or folder, etc. Other users
may be able to perform file or folder operations, depending on
their roles.

15
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Roles and Privileges on Files

The following table indicates which file operations can be performed by the various roles.

Note: The Admin role is not shown in the table. The Admin role can
perform all the listed actions, plus:

Change file ownership
Configure global settings that impact all repository users

ACTION: Viewer Contributor Collaborator Coordinator Owner
View ] ° ] ° ]
Cut o(if . . .
owner)
Copy ] ° ] ° ]
Paste o . o . o
Update . . . .
Download ® ° ® ° ®
Delete o(if . ° s
owner)
Workflow (cascading
menu)
Check In o(if . . .
owner)
Check Out o(if . . .
owner)
Undo Check o(if . . .
Out owner)
Submit for o(if . . .
Approval owner)
Undo Submit o(if . . .
for Approval owner)
Approve e(if owner)  ®(if owner) *(if
owner)
Reject e(if owner)  ®(if owner) *(if
owner)

Favorites (cascading

16



User Roles

menu)
Add to My & .
Favorites
Remove from . .
Favorites
Set Alert . o
Reports (cascading
menu)
View Version . .
History
View
Previous . ]
Version
Rest?re o(if
Previous owner) o
Version
View Audit o(if .
Log owner)
View Properties . .
Edit Properties o(if .
owner)
Edit name, .
. o(if
description, owner) o
and keywords
Enable or
disable o(if .
approval owner)
workflow
Manage o(if .
effective dates owner)
Manage access o(if .
owner)

17
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Roles and Privileges on Folders

The following table indicates which folder operations can be performed by the various
roles.

Note: The Admin role is not shown in the table. The Admin role can
perform all the listed actions, plus:

Assign fax numbers to folders
Change folder ownership
Configure global settings that impact all repository users

ACTION: Owner

Coordinator

Viewer Contributor Collaborator

View

Add new folders
and files

Cut

s (if owner)

e (if owner)

Copy

Paste

Download folder
as *.zip file

Delete

o (if owner)

e(if owner)

Favorites
(cascading menu)

Add to My
Favorites

Remove
from
Favorites

Set Alert

View Properties

Edit Properties

s (if owner)

e (if owner)

Edit name,
description,
and
keywords

s (if owner)

e (if owner)

Enable or
disable

o (if owner)

o (if owner)

18



User Roles

approval
workflow

Manage

o (if owner) o (if owner) . o
access

19






STUFF VIEWERS CAN DO

Alerts

Removing an Alert

1. Navigate to the item from which you want to remove an alert.
2. Click the drop-down arrow at the far right of the file name.

Where is the drop-down arrow?

Folder Actions Admin Help View: Al Documents
HOME = MIKETEST1 = MIKE TEST A Search Documents

April 13, 2011 01:23

CAPTIVATE_mousedcik.gif [N 1o =2
[ - a Cut PM EDT

| . | [ Copy April 12, 2011 01:23
x| My Groups Test 2.xls bl
PM EDT

@ Download
& Delete

Waorkflow

Favorites & Alekts| &) Add to My Favorite

Reports f

@ View Properties
El Edit Properties

3. From the Favorites and Alerts menu option, click Set alert. The Set ALERT ON
File... screen displays.
4. Clear the Email alert activated check box.

21
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Secure File Exchange

Folder Actions | Admin | Help | View: Al Documents

HOME > MIKETEST1 > MIKE TEST A > CAPTIVATE_MOUSECLCIK.GIF

i}l Set ALERT OM File "CAPTIVATE_mouseclcik.gif*

An alert will be sent to the email address you have registered in "My profile” when this file is updated

deleted.

OK CANCEL

5. Click OK. Alerts will no longer be sent to your email account when the item is
modified.

RESULT:

You have removed an alert.

22



Setting an Alert

1. Navigate to the item for which you want to set an alert.
2. Click the drop-down arrow at the far right of the file name.

Stuff Viewers Can Do

Where is the drop-down arrow?

Folder Actions Admin Help

HOME > MIKETEST1 > MIKE TEST A

D::.=T|.':.Tz_n-:,sazlzi--;if =m T % cut

|:J Copy

| Download

g Delete

Waorkflow

Reports

3. From the Favorites and Alerts menu option, click Set alert. The Set ALERT ON

File... screen displays.
4. Select the Email alert activated check box.

ﬁﬁ__l View Properties
El Edit Properties

View: Al Documents

Search Documents

April 13, 2011 01:23
PM EDT
April 13, 2011 01:23

PM EDT

Favorites & Alekts| &) Add to My Favorite

@ Setalert

23
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Secure File Exchange

Folder Actions | Admin | Help | View: Al Documents

HOME > MIKETEST1 > MIKE TEST A > CAPTIVATE_MOUSECLCIK.GIF

i}l Set ALERT OM File "CAPTIVATE_mouseclcik.gif*

An alert will be sent to the email address you have registered in "My profile” when this file is updated

deleted.

OK CANCEL

5. Click OK. An alert will be sent to your email account each time the item is
modified.

RESULT:

You have set an alert on an item.

24



Favorites Menu

Stuff Viewers Can Do

Adding an Item to "My Favorites" List

1. Navigate to the file or folder you want to
add to your Favorites list.

2. Click the drop-down arrow at the right of
the item's name.

Where is the drop-down arrow?

Folder Actions Admin Help
Click

HOME > MIKETEST1 = MIKE TEST A
D CAPTIVATE _mouseccik.gif TEM =

d Cut

E_] Copy
EI Groups Test 2.xis [T

E—_} Download

i@ Delete

Workflow

Reports

Qﬁ_| View Properties
EI Edit Properties

3. From the Favorites and Alerts menu
option, click Add to My Favorites. A
confirmation message displays.

View: Al Documents

Search Documents

April 13, 2011 01:23
PM EDT
April 13, 2011 01:23

FM EDT

Favorites & Alekts| &) Add to My Favarite

b ;
@ SetaAlert

25
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Secure File Exchange

Folder Actions ~ Admin | Help | View: Al Documents

ﬂmam_mwmmmmmrmiﬁm|
HOME = MIKETEST1 > MIKE TEST A

‘Search Documents

SIZE TYPE MODIFIED DATE

April 13, 2011 01:23 |
D CAPTIVATE_mousecicik.gif EEZEH 43KB gif
PM EDT
April 13, 2011 01:23
@ My Groups Test 2.xls FEEA 18KB xls
PM EDT

The file or folder will appear in the
favorites list when you select "My

Favorites' from the View drop-down
menu.

Where is the View drop-down menu?

Secure File Exchange

Folder Actions | Admin | Help | All Documents

All Documents
HOME ‘Search De My Favorite&@

NAME B Ters My Check Ou

. My Approvals
I:l chris123 MY Alerts
Recycle Bin
[F51 christest '

RESULT:
You have successfully added an item to favorites list.

26



Stuff Viewers Can Do

Removing an Item from My Favorites List

1. Navigate to the item you want to remove
from your Favorites list.

2. Click the drop-down arrow at the far
right of the file name.

Where is the drop-down arrow?

Folder Actions Admin Help View: Al Documents
Click
HOME = MIKE TEST 1 > MIKE TEST A Search Documents

April 13, 2011 01:23

D CAPTIVATE _mouseccik.gif TEM - f i
d-a Cut PM EDT
0 Copy April 12, 2011 01:23
EI Groups Test 2.xls B b &
PM EDT

E—_} Download
i@ Delete

Workflow

Favorites & Alekts| &) Add to My Favarite

Reports 3 )
@ SetaAlert

Qﬁ_| View Properties
EI Edit Properties

3. From the Favorites and Alerts menu option, click Remove from Favorites. A
confirmation message displays.

27
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Folder Actions Admin Help 4 [Back Wiew: My Favories

MY FAVORITES

Search Documents

wpril 13, 2011 01:23

_ Home/Mike Test 1/Mike Test A \%
[HiE | Cut FM EDT
Copy March 11, 2011 04:31
cloadden Harme/chrie] 73 e,
Dw. adde b ome/chris123 45

AM EST

Download

O T

Delete

Workflow

Favorites & Alekts

B

-

Reports (3

@ View Properties
Edit Properties

This file or folder will no longer appear in the list when you select 'My Favorites'
from the View drop-down menu.

Where is the View drop-down menu?

Folder Actions Admin Help

View Menu, available
from most SFX screens

View: Al Documents

All Documents

HOME Search D¢ My Fa\.fnr'rtesﬁ_?

My Check Qu
a—— ”: My Approvals
Fol9er amesT | My Alerts

March 11, _REC‘,"C'EEII'I

christest Frldar = A

28




Stuff Viewers Can Do

RESULT:

You have successfully removed an item to favorites list.

29
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Downloading a Document

1.

Locate the file you want to download by searching or browsing the folder

hierarchy.

2. Click the drop-down arrow at the right of the file name.

kW

Folder Actions Admin
MY FAVORITES

[) CAPTIVATE mousec
(HEH!]

D Upl =

Click Download.

Help

Workflow 3
Favorites & Alekts

Reports 3

@ View Properties
El Edit Properties

Mowember 12, 2008

~ D4:47 PMEST

April 13, 2011 01:23

PM EDT

March 11, 2011 04:31

AMEST

In your PC's File Download dialog, click Save.
Navigate to the location to which the file should be downloaded.

Click Save.

4 |Back View: |My Favorites

Search Documents

Homelchris123

RESULT:

You have successfully downloaded a document.

30




Stuff Viewers Can Do

Downloading a Folder and its Files

This task does not download subfolders and their contents. You can
perform this task only to download the files that are stored directly under
a folder. For example, If My Folder I contains only folders, you cannot
download My Folders 1, even if its subfolders contain files.

You can download a folder and the files stored directly under it as a zip file.

1.
2.

W

Navigate to the folder you want to download.
Click the drop-down arrow at the far right of the file name.

Where is the drop-down arrow?

Secure File Exchange

Folder Actions Admin Help View: Al Documentz

HOME |Se arch Documents

STATUS  SIFE TYPE MODIFIED DATE =

April 13, 2011 12:49

5| Mike Test 1 [=L Colder =
= dlé' Cut FM EDT
Copy April 11, 2011 11:50
[E3] Cov QA - April11 ED lder ==
ﬁ Paste AM EDT
March 23, 2011 04:43
[5] Testing FUF-2168 [} Download files 35 Jider &g
FM EDT
& Delete
March 18, 2011 01:24
[55] Stg-Chrysler_SFx_NewFolder-laya-3-18-2011 Ider ==
Favorites & Alebts PM EDT

. March 18, 2011 01:12
[ z-Linda-Test fi] View Properties  fige &g

FM EDT
@' Edit Properties

March 11, 2011 05:01

Click Download files as...

The system generates a zip file of the files within the folder and prompts you do
open or save the file. Click Save.

Navigate to the location to which you want to save the generated zip file and click
OK. The zip file is saved.

31
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RESULT:

You have successfully downloaded a folder and its contents.
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Stuff Viewers Can Do

Viewer Tasks

Every SFX user can perform tasks permitted by the Viewer role. Some users are
assigned roles that permit additional tasks.

Review this section and its related topics before performing tasks assigned to additional

user roles. For more information, refer to Roles and Privileges on Files and Roles and
Privileges on Folders.

; Folder pctions = Admin ™ Help = Wiew: | Al Documents ‘(L

HOME > TRAINING FOLDER > SIGN IN SHEET

9/28/07 2145113 A
G501 _q_zon7 Fafdg 2R

ECT

9/28/07 S144:

D2.0Q.2007 Folder
ST EDT

0z g_zoo7 Falder

SFZZf08 3102129
EDT
SFZ2f08 213414
ECT

[t

@ ClearingCacheFiles . dac

3TKR JAmap

?AII Diocumerts
EMy_Fa\rD_rites :
My Check OU{D
EMy Lpprovals

My Alarts
|Recycle Bin

| Misw Properties bl TR TR (TS
i N f..l.. i
] Edit Froperties ! “QE' S li{h-']

Viewing Files/Folders

@ 1. Click on the View drop-down arrow to the right of the 'view' window.
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2.

Where is the View drop-down menu?

The View drop-down menu is displayed in the upper right
corner of the toolbar:

Secure File Exchange

Folder Actions Admin Help iew:  All Documents "
All Documents |

HOME Search D¢ My Favorites {:? ]
- My Check Ou
1
=) chrisi2 Marcn 11, MY Approvals
[ chris123 Folder anzst | My Alerts
Recycle Bin
[l christect S March 11 e &=

Select the 'view by' filter from the menu.

@

Managing Files and Folders

1.

2.

Take action on a file or folder by clicking the drop down arrow to the
right of the file/folder.
Some menu options have additional submenus, such as Favorites.

@

Identifying Your Role

1.

Icons indicate your role on an item. Hover your mouse over the icon
for details.

2. The 'person'icon indicates you are the owner of the item.
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Viewing a File or Folder

1. Drill down into the folder structure until you reach the desired file or folder.

2. Click a folder name to display the folder's contents.
3. To view a file, click the file name and follow your PC's prompts to open or save

the file.

Some files may have expiration dates. When the file is expired, it is
removed from view for users who have only the Viewer role.

RESULT:

You have successfully viewed a file or folder.
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Viewing Access Rights of Others on an Item

36

1. Click the drop-down arrow at the far right of the file or folder name.

Where is the drop-down arrow?

Folder Actions Admin Help

HOME > MIKE TEST1 > MIKE TEST A

D CAPTIVATE mousedcik.gif EEEH

View: Al Documents

Search Documents

- ¢ [
oy M PM EDT
[y Copy Agril 13, 2011 01:22
P2t
Pl EDT
@. Download

@ Delete

April 13, 2011 01:23

Workfiow 3

Favorites & Alekts

Reports

ﬁi | View Pru:upq&ties
B Edit Propeh—£s

3

2. Click View Properties. A list of users per role is displayed.

3. Click OK when finished viewing.

RESULT:

You have successfully viewed access rights.



Viewing Properties

Stuff Viewers Can Do

1. Click the drop-down arrow at the far right of the file name.

Where is the drop-down arrow?

Folder Actions Admin Help

HOME > MIKE TEST1 > MIKE TEST A

D CAPTIVATE mousedcik.gif EEEH G'é Cut
3 wm =l
Groups Test 2.xl
@. Download

@ Delete

Workfiow

Reports

ﬁi | View Pru:upq&ties
B Edit Propeh—£s

2. Click View Properties from the menu.

3

Favorites & Alekts

3

View: Al Documents

Search Documents

April 13, 2011 01:23
PM EDT
April 13, 2011 01:23

PM EDT

3. When you are finished viewing the properties, click OK to return to the file list

screen.

RESULT:

You have successfully viewed file/folder properties.
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Viewing Version History

1. Click the drop-down arrow at the far right of the file name.

Where is the drop-down arrow?

Folder Actions Admin Help View: Al Documents
HOME = MIKETEST1 > MIKE TEST A Search Documents

April 13, 2011 01:23

D CAPTIVATE _mouseclcik.gif CIEEH 43KB  gif ==
PM EDT
. | April 13, 2011 01:23
- Groups Test 2 L - E ===
) af Cut FM ECT
) copy

@ Download
@ Delete

Workflow b

Favorites & Aleks

Reports b |[E] Version g’i];ur-;
= Audit L
.iia_| ‘iew Properties D FHAtke

El Edit Properties

2. Select Reports -> Version History. The file's version history displays.
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Secure File Exchange

Folder Actons | Admin | Help | View: Al Documents

HOME > MIKETEST1 > MIKETESTA > MY GROUPS TEST 2.XLS

VERs# COMMENTS APPROVER  MODIFIED BY MODIFIED DATE
1.0 Erik Johnson April 12, 2011 01:23 PM EDT
1.1 Add q user ID Erik Johnson April 15, 2011 09:33 AM EDT

o

3. When you are finished viewing the history, click OK to return to the file list
screen.

RESULT:
You have successfully viewed version history.
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Sending a Link to a File or Folder

Users can send the URL of a specific file or folder to another portal user. The recipient
must have a login ID to your portal, as well as the appropriate access rights on the item.
For example, the user could complete the steps below to paste the direct URL to a folder
or file into an email. By sending the email to another user, that person would be able to
click the URL in the email, and after logging in, land directly in the SFX directory of the
file or folder belonging to the URL.

Folder Actions Help Wiew: | Al Documents w
HOME Search Documents m
October 18, 2007 0310
Accountin Falder ==
=l : Pl ECT J
Julw 19 5
[ Credentialing Lold == J
Resource Link
) ) . 1BFM
[ Executive Staff (WResource Link J

Below is the link to the resource, Copy and paste the link into an
email, document, bookmark, or other source,

% |https:,r',-“n:n:uvisint.cnmfsfx?linkNDdeld=?EEb?EDf—?EE

Close this window

1. Navigate to the file or folder to which you want to embed a direct link in an email
or other document.

2. Click the ® link icon in the LINK column to the far right of the file or folder

display window. The Resource Link window displays the URL of the item.

Copy the URL of the item.

Click Close this window.

5. Paste the URL where it is needed, such as within a document, email, etc.

W

Document recipients must have an SFX login with the required roles on
your portal In order to view the item referred to by the link.

RESULT:

You have successfully sent a link to a file or folder.
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WORKING WITH FILES

File Workflows

Some organizations to not implement the "Approval Required" workflow
option.

If your implementation does not support the Approval Required
workflow, you will not see the approval-related options referred to in
some procedures. You will follow the process described in the "No
Approval Required" workflow.

If your organization's implementation supports the "Approval Required" workflow, there
are options for how it can be configured by your administrator:

e Approval can be required for all files in the repository. In this case you must
always follow the "Approval Required" workflow.

e Approval can be required for certain files, depending on file property settings. In
this case, you will alternate between the "Approval Required" and the "No
Approval Required" workflows as required by each file's properties.

If you are not sure which workflow to follow for a specific file, view the
file properties.

e If the "Require Approval" check box is not selected, follow the "No
Approval Required" flow.

e |f the "Require Approval" check box is selected, follow the "Approval
Required" flow.

No Approval Required Workflow

Add Files to SFX Madify Files Publish Files on SFX

@ "Edit File using PC Software" is a process you perform with your PC and
the appropriate software required to edit the downloaded source file. It is
not an SFX task.
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Approval Required Workflow

Add File to

Add Files to SFX

Submit File

for Approval

Download
File

Update Fila

Publish Files on SFX

Submit File

for Approval

i

"Edit File using PC Software" is a process you perform with your PC and
the appropriate software required to edit the downloaded source file. It is
not an SFX task.
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Adding or Uploading a New File

@ Note: The following special characters are not allowed in file names:

/| & :%+? ;%

We recommend you do not include spaces in the names of files stored on
SFX.

1. Navigate to the folder to which you want to upload the file. (Or create a new

folder.)
|'Folder Actions | Admin Help View: Al Documents b
Mew Folder
[Z) Upload File 1 = MIKETEST A Search Documents

@ Download filesas
April 18, 2011 01:13

Favorites and Aterticik.gif [ Drsft 43KE  gif 2
FM EDT
& Cut April 18, 2011 10:20
[HEH!| 18KB s 2
[y Copy AM EDT

& Delete
@ View Properties
B Edit Properties

2. From the Folder Actions menu, click Upload File. The upload screen displays.

Note: Your roles may not allow you to modify optional fields. For details,
refer to Additional Options when Uploading a File.
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Secure File Exchange
Folder Actions | Admin | Help View: Al Documents E

HOME > MIKETEST1 > MIKE TESTA

| | cREATE FILE(s)

Description:

O Require approval -/

peFiges to File(s) are subject to approval ]

O Viewer(s) can access this file between the date range specified 2]

Upload file:
@ Add another file
ﬂ CANCEL
3. Click Browse.
4,

Browse to and select the file you want to upload.

5. Optional:Upload additional files by clicking the ** Add another file link, and
repeating steps 3-4.

6. Click OK.
o Ifapproval is not required, your uploaded file will be accessible
immediately.

o Ifapproval is required, your file is uploaded as a draft. Your file is not

available to SFX users until it is approved. Proceed to the section entitled
Submitting a Draft for Approval.

RESULT:

You have successfully uploaded a file. Next, you may wish to allow others
access to your files.

If you wish to set approval or effective dates, descriptions or keywords, refer to
Additional Options when Uploading a File.
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Additional Options when Uploading a File

@ Depending upon your role, you may be able to set additional options when
uploading a file, as described below.

Secure File Exchange
Folder Actions | Admin | Help View: Al Documents E

HOME > MIKETEST1 > MIKE TESTA

| | cREATE FILE(s)

Description:

O Require approval -/

ges to File(s) are subject to approval ]

O Viewer(s) can access this file between the date range specified 2]
Upload file:

@ Add another file [%
ﬂ CANCEL

Complete the following optional fields, as required:

1. Enter comma-separated keywords and phrases in the Keyword field. The

keywords are associated with the file, and are used to locate the file during
searches.

2. Type a description of the item.

3. Require approval on any updates made to this item by selecting the Require
approval check box. Learn more >>>

4. Set effective dates for the item by enabling the Viewer(s) can access this file
between the date range specified check box.

a. Click to select the viewing availability Start Date.
b. Click to select the viewing availability End Date.
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When an access date range is specified, users with only the 'Viewer' role
can access the file during the specified date range. Once the End Date has
passed, users with only the Viewer role can no longer access the item.

Access for Contributors and Collaborators is not affected by the date
range.

5. Click OK.

o Ifapproval is not required, the file will be accessible immediately.
o Ifapproval is required, your file is uploaded as a draft. Your file is not

available to SFX users until it is approved. Proceed to the section entitled
Submitting a Draft for Approval.

RESULT:
You have successfully set options for a file.
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Canceling a Checkout

1. Navigate to the checked out file.
2. Click the drop-down arrow at the far right of the file name.

Where is the drop-down arrow?

Folder Actions Admin Help View: Al Documents
Undo
HOME > MIKE TEST1 > MIKETES Search Documents
April 19, 2011 01:54
subfolder_1 Folder ==
P ECT

April 21, 2011 01:18

D CAPTIVATE_mousedlcik.gif [y
PM EDT
. n . . April 20, 2011 02:20
D CAFPTIVATE_mousedidessa.gif FEIH &2
PM EDT
My - >l April 20, 2011 04:22
&' My Groups Test 2.xls ==
PM EDT
e : April 21, 2011 08:48
554 approval_required.doc &=
@ - - Workflow

Favorites & Al .
E Unda Check out

Reports B Sub r Approv,

fi| View Properties
El Edit Properties

3. From the Workflow option, click Undo Check out. The screen refreshes and the
file is no longer checked out.
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Secure File Exchange

Folder Actions ~ Admin | Help | View: Al Documents

ﬁﬁmTﬁtwmmmﬂm‘

HOME > MIKETEST1 > MIKETESTA |Search Documents
NAME STATUS  SIZE TYPE MODIFIED DATE L

April 12, 2011 01:23

DC&F“TIVATE_mnusedI:it.gif [HE W] 43KB  gif
PM EOT

April 18, 2011 09:37

@ My Groups Test 2.xls EEEH 18KB  .xls
AMEDT

RESULT:

You have successfully cancelled a file checkout.
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Changing File or Folder Ownership

This task can be performed only by an SFX Administrator.

A file or folder can have only one owner.

1. Navigate to the file or folder whose owner you want to change.
2. Click the drop-down arrow at the far right of the file/folder name.

Where is the drop-down arrow?

Folder Actions Admin Help View: All Documents

Edit Properties

HOME = MIKE TEST1 > MIKE TEST A Search Documents

April 13, 2011 01:23
D23=TI.3TE_"':,se:I:i- gif EEEH =2
PM EDT
April 18, 2011 0237
EI My Groups Test 2.xs [ =2
AM EDT

El Edit Properties

3. Click Edit Properties. A list of file/folder properties is displayed.
4. Click @ nextto Change Owner. The User Directory window displays.
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Secure File Exchange

Folder Actions Admin Help View: Al Documents

HOME > MIKE TEST1 > MIKE TEST A > CAPTIVATE_MOUSECLCIK.GIF

|| EDIT PROPERTIES

Name:

CAPTIVATE_mousedcik gif

Drescription:

Keywords:

r Require approval
r Effective dates Vig

¥ Uncheck this box

COORDINATOR:
COLLABORATOJY Bead, Debby :Chrysler, Tester Three ;Deed, Dians
VIEWER: Cj er Portal: Services for Chrysler/EVERYOMNE; Chrysler Portal: Services for Chrysler Fina
Services/ B\ ONE
DWNER,
@ Change Cwner
'@' Jo

OK CANCEL

a. Type the name (or partial name) of the user you want to assign as the item
owner in the Type in name field.

b. If you want to restrict your search to individual users, click the Include
drop-down arrow and select Users from the list.

c. Click Find. The screen refreshes, and the search results display.

d. Select the check box of the user you want to designate as the item
owner. An item can have only one owner. The user's name displays in the
Selected People box.

e. Click OK. The User Directory window closes and the owner selection
displays in the Edit Properties window.

5. Click OK. The previous owner is removed from the item's ownership and the new
owner is assigned.
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RESULT:

You have successfully changed ownership of a file or folder.
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Checking In a File (approval required)

54

When approval is required, you do not use Check Out/Check In to control
file access. Instead, you upload a modified version of a file to put it in
Draft status, then you submit the draft for approval to begin the process of
making the new version available to users.

If you Check Out a file that requires approval workflow, you will not be
allowed to upload a new version of the file until you cancel the Check
Out.

1. Navigate to the file that has been downloaded, modified, and updated on SFX.

The file is in Draft status.

2. Click the drop-down arrow at the far right of the file name.

Where is the option?

Folder Actions Admin Help View: All Documents

Submit the
updated file

HOME > MIKE TEST1 > MIKE TEST A Search Documents

April 18, 2011 01:13

D CAPTIVATE mousedcik.gif EEEH
PM EDT
0 Copy April 18, 2011 10:20
gl My Groups Test 2.xls EEEH
AMEDT

@ Download

Workflow I

Favorites & Alekts
—Mlindo Chedk out

uh%ﬁ:r Approv

b

Reports

di| View Properties
B Edit Properties

3. From the workflow option, click Submit for Approval. The screen refreshes and
the file status is set to Pending.
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4. The file must be approved before it will be available to other users.

RESULT:

You have successfully checked in a file.
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Checking In a File (approval not required)

56

1. Navigate to the checked out file that has been updated.

2. Click the drop-down arrow at the far right of the file name.

Where is the option?

Folder Actions Admin Help

HOME > MIKE TEST1 > MIKE TEST A

D CAPTIWATE_mouseclcik.gif BEEEH

@ My Groups Test 2.xls EIEEH

Chedoed

View: Al Documents

Search Documents

April 13, 2011 01:23

PM EDT

April 15, 2011 09:29

E;_] Copy

E{} Download

Workflow

Favorites & Alepts

Reports

|j§_| View Properties
E/ Edit Properties

AMEDT

2 @ Check inl{b

E:; Undo Chedk out
2

3. From the Workflow option, click Check in. The screen refreshes and the file is

unlocked.

RESULT:

You have successfully checked in a file.
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Checking Out a File

Checking out a file 'locks' the file so that other users cannot upload new
versions of the file. Users can view and download a checked out file.

Note: If Approval is required, you cannot upload a new version of a
checked out file. In that case, you must:

e undo the check out
e upload the new version of the file.

1. Navigate to the file you want to check out.
2. Click the drop-down arrow at the far right of the file name.

Where is the drop-down arrow?
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Folder Actions Admin Help View: All Documents

HOME > MIKE TEST1 > MIKE TEST A Search Documents

April 13, 2011 01:23

D CAPTIVATE mousedcik.gif EEEH gif e
PM EDT
April 13, 2011 01:23
@ Groups Test 2.x1s R T o ==
& Cut PM EDT

L|_4 Copy

@ Download
@ Delete

Workflow (2

E_;l Check out
Favorites & Alekts l*\ﬂ_”)
Reports F

qf|_| View Properties
El Edit Properties

3. From the Workflow option, click Check out. The screen refreshes and the file is

checked out.

Folder Actions Admin Help View: Al Documents

"My Groups Test 2.x1s" has been CHECKED OUT!

HOME > MIKETEST1 > MIKE TEST A Search Documents

April 13, 2011 01:23

D CAPTIVATE_mousedcik.gif [N 43KB .gif =
PM EDT
o . I ChECkEd Chedwed April 15, 2011 08:13
Wy Groups Test 2.xls 18KB  .xls =
&I OUt Out - AMEDT
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RESULT:

You have successfully checked out a file. After modifying the file, perform the
steps to store the updated file in SFX, and then perform the file check in task.
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Copying a File or Folder to a New Location

1. Navigate to the file or folder you want to copy.
2. Click the drop-down arrow at the far right of the file or folder name.

Where is the drop-down arrow?
==
Folder Actionsz Help View: Al Documents
HOME > A_MIKETEST_FOLDER Search Documents
April 19, 2011 12:56
Mike Test A .~ Her ==
& Cut FM EDT
[y Copy April 19, 2011 12:55
Uploaddemo.ba I &=
D {b FM EDT

@ Download files as .|
& Delete

Favorites & Alekts

@ View Properties
B Edit Properties

3. Click Copy. The file or folder (with its files and subfolders) is copied to the
clipboard.

4. Navigate to the target location.

5. From the Folder Actions menu, click Paste.
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eeq
Folder Actionz Help View: Al Documentz
Mew Folder
[Z] Upload File T_FOLDER Search Documents
@. Download files as
Favmites and Mer S April 189, 2011 12:581 o
PM EDT
4 Cut

0 copy
Eﬁ Paste \“i')

& Delete

@ View Properties

B Edit Properties

Copying files or folders creates duplicate items. Changes to a file or
folder in one location do not apply to copies in other locations.

RESULT:

You have successfully copied a file/folder to a new location.
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Deleting a File

You must be the file owner or have an appropriate SFX role to delete a
file. Deleted files are moved to the Recycle Bin. Only an SFX
Administrator can restore files that have been moved to the recycle bin.

1. Navigate to the file you want to delete from SFX. You cannot delete a file that is

checked out.

2. Click the drop-down arrow displayed to the far right of the file name.

Where is the drop-down arrow?

Secure File Exchange

Folder Actions Admin Help

HOME = MIKETEST1 = MIKETEST A

D CAPTIVATE_mouseclcik.gif EEZH

@ My Groups Test 2.xls EIEIH

—

|@ My GroupsTest 2.xIs W

g Cut
0y Copy
Ej Faste

Q Download
& Delete

Workflow I
Favorites & Alekts

Reports (2

Q iew Properties
@]‘ Edit Properties

View: Al Documents

W

PE

‘Search Documents

MODIFIED DATE LINg
il 12, 2011 01:23
April 13, &3
FM EDT
il 15, 2011 08:13
Apri &3
AM EDT
il 18, 2011 08:31
Apri &g

AM EDT

3. Click Delete.
4. Click Yes to confirm deletion.

RESULT:

You have successfully deleted a file.
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Working with Files

1.

Locate the file you want to download by searching or browsing the folder

hierarchy.

2. Click the drop-down arrow at the right of the file name.

kW

Folder Actions Admin
MY FAVORITES

[) CAPTIVATE mousec
(HEH!]

D Ugpl =

Click Download.

Help

Workflow 3
Favorites & Alekts

Reports 3

@ View Properties
El Edit Properties

Mowember 12, 2008

~ D4:47 PMEST

April 13, 2011 01:23

PM EDT

March 11, 2011 04:31

AMEST

In your PC's File Download dialog, click Save.
Navigate to the location to which the file should be downloaded.

Click Save.

4 |Back View: |My Favorites

Search Documents

Home/chris 23
CIMEe Crs] L A

RESULT:

You have successfully downloaded a document.
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Updating a File

This procedure assumes you have downloaded and modified a file, and you want to
update it on SFX.

@ You create or edit files outside of SFX, using an appropriate software program.

1. Navigate to the folder that contains the file you want to update.

| Folder Actions | Admin Help View: Al Documents e
Mew Folder
D Upload File 1 > MIKE TESTA Search Documents

@ Download filesas £
April 18, 2011 01:12

Favorites and Merpicik gif [EI Draft 43KB  qif == ‘%.
PM ECT
‘fé' Cut April 18, 2011 10:20
: HEH!] 18KB s . = 8
|:|J Copy AM EDT

& Delete
@ View Properties
B Edit Properties

2. From the Folder Actions menu, click Upload File.
3. Click Browse. View file name restrictions >>>

@ Note: The following special characters are not allowed in file names:
/| & :%+? 5 %

We recommend you do not include spaces in the names of files
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stored on SFX.

4. Browse to and select the file you want to upload.

5. Optional:Set approval or effective dates, descriptions or keywords, as required.
For details, refer to Additional Options when Uploading a File.

6. Click OK. A confirmation dialog similar to the following is displayed.

Confirm file(s) replace ®

Wiould you like to replace the existing fileds 2
TearnRoorn (TR ).rmrmap

[ (9] 4 ][ Cancel ]

k.

7. Click OK. The file is uploaded and a new version is created.

a. If approval is not required, your uploaded file is set to Checked Out
status. Perform Checking in a File (no approval) when you are ready to
make the file available to other users.

b. If approval is required, your uploaded file is set to Draft status. Perform
Submitting a Draft for Approval when you are ready to make the file
available to other users.

RESULT:

You have successfully updated a file.
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Editing File or Folder Properties

You must be the item owner or have the required permissions to perform
this task.

1. Navigate to the file or folder whose properties you want to edit.
2. Click the drop-down arrow at the far right of the file/folder name.

Where is the drop-down arrow?

. d ) Pask
Secure File Exchange 0 Paste
Q Download

& Delete
Folder Actions | Help | View: Al Documents
Workflow b
HOME = MIKE TEST 1 Favorites & Alekts |Search Documents

e " oorcoome

Reparts
April 19, 2011 01:54

5| Mike Test A ) = &2
= Q View Properties FM EDT
[ Edit Pfﬂjﬁﬁes April 19, 2011 09:32
|® SS4_no_spproval.doc [ 1 &2
A AM EDT

3. Click Edit Properties. The Edit Properties window displays.
4. Edit the properties as desired.
a. Edit approval requirements as desired. (Refer to the section entitled
Removing Approval Requirements from a File or Folder or Requiring
Approval on a File for further details)
b. Some users can change the file owner. See Changing File / Folder Owners
for details.
c. Optionally, modify access permissions to the file or folder by following
the steps in the section entitled Modifying Access Rights.
5. Click OK.

RESULT:

You have successfully edited the properties of a file or folder.
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Modifying Access Rights to a File or Folder

68

@ Files and folders inherit access rights from the folder in which they reside.
Users with appropriate privileges can modify access rights.

Performing these steps to a folder applies to the folder, and to its

subfolders - unless you further modify the subfolders.

Performing these steps for a file applies only to the item with which you
are working and does not impact access rights to other files.

Navigate to the file or folder whose access rights you want to modify.

I navigate to a file or folder?)

(How do

Click the drop-down arrow at the far right of the file/folder name.

Where is the drop-down arrow?

Folder Actions Admin Help

Edit Properties

HOME > MIKETEST1 = MIKE TEST A

D CAPTIWATE_mousecicik.gif EEIH

HEH!]

EI My Groups Test 2.xls

El Edit Properties

3. Click Edit Properties. The Edit Properties window displays.

View: All Documents

Search Documents

April 12, 2011 01:22

===
FM EDT
April 18, 2011 0227

===

AM EDT
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Secure File Exchange

Folder Actions | Help | View: Al Documents

HOME > MIKETEST1 = TEST2-INHERITANCE

|| EDIT PROPERTIES

Name:

|TEt2—il'l|‘ElitEll‘lEE
Description:

Tahoma ;||BIQ|A‘ Av|£

&
M
i
il
@.
i
&

Upload Custom Icon:

Select an icon:

Submit

r Require approval Changes to files(s) are subject to approval 2]

1 Uncheck this box to remove inherited access controls from the folder above L2
FOLDER ADMIN:

COORDINATOR: Chrysler, Tester Two

COLLABORATOR: Deed, Debby :Deed, Diane :Chrysler, Tester Threa
CONTRIBUTOR: View, Victor ;02, ssatraining :Seashell, Sally :Chrysler, Tester Four

VIEWER: Chrysler Portal: Services for Chrysler/EVERYONE; Chrysler Portal: Services for Chrysler Finan
Services/ EVERYONE

OWNER: ssatraining 02

oK CANCEL

4. Clear the check box next to Uncheck this box to remove inherited access
controls... A confirmation dialog displays.

5. Click Yes to remove inherited access controls for the item. The Edit
Properties refreshes and displays the set of properties you can modify
for the item.
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Secure File Exchange

Folder Actions |Heb | View: Al Documents

HOME = MIKE TEST1 = TESTZ-INHERITANCE

|| EDIT PROPERTIES

Name:

|TrEt’2-i nheritance

Description:

Tahoma B I U AANA Y EEEgEEE

Upload Custom Icon:

Select an icon:

Submit

r Require approval Changes to files(s) are subject to approval L2
[ check this box to inherit access controls from the folder above &
n FOLDER ADMIM:

E COORDINATOR:
@Ad d Members

'@ Tester Two

H COLLABDRATOR:
@Ad d Members

il Deed, Debby , [ Deed, Diane

E CONTRIBUTOR:
@Ad d Members

il View, Victor , il 02, ssatraining , [ Seashell, Sally

ﬂ VIEWER:
@Ad d Members

OWMNER: ssatraining 02

Ok CANCEL
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6. If you want to provide access to members, click @ next to Add Members in the
role type to which you want to add users. The User Directory window displays.

a.

b.

C.
d.

.

f.

Type the name (or partial name) of the user or group you want to add in
the Type in name field.

If you want to restrict your search to individual users, click the Include
drop-down arrow and select Users from the list.

Click Find. The screen refreshes, and the search results display.

Select the check box of the users and groups you want to add. The users
display in the Selected People box.

Repeat steps a through d as required until you are finished adding users.
Click OK. The User Directory window closes and the added members
display in the Edit Properties window.

7. 1f you want to remove access to the file or folder, click I, the wastebasket icon,

next to the users and groups whose access you want to remove.
8. Click OK.

RESULT:

You have successfully modified access rights on an item.
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Moving a File or Folder with Cut

@ You must be the file or folder owner or have an appropriate role to move
a file or folder using Cut.

1. Navigate to the file or folder you wish to move.
2. Click the drop-down arrow at the far right of the file name.

Where is the drop-down arrow?
1=y
Folder Actions Help View: Al Documents
HOME = MIKE TEST1 > TEST2-INHERITANCE Search Documents
April 12, 2011 02:19
Ssnheanes q Cut T -
E;] Copy %

Favorites & Alekts

@ View Properties
E/ Edit Properties

3. Click Cut.
4. Navigate to the location to which you want to move the file or folder..
5. From the Folder Actions menu, click Paste.

Where is the option?
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eeq

Folder Actionz Help View: Al Documents

Mew Folder
[Z] Upload File »T_FOLDER Search Documents
E} Download files as |

Favarites and Aler Folder April 189, 2011 12:581 o

PM EDT
Cut

Copy

Paste \“i')

Delete

View Properties

P
o
[§)
&
)
B

Edit Properties

RESULT:

You have successfully cut and pasted a file or folder.
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Requiring File Approval

If your SFX Administrator configures all items in the repository to require approval,
approvers are established at the repository level for all folders and files within the
repository. You cannot turn off approval workflow for your items, and you cannot select
your Own approvers.

If approval is not required at the top repository level, and is not required at the folder
level by the folder owner or an administrator, you can require approval of files for which
you are the owner. Complete the following steps to require approval on a file.

1. Navigate to the file for which you wish to require approval.
2. From the file drop down menu, click Edit Properties. The Edit Properties
window displays.

Folder Actions Admin Help View: All Documents

Edit Properties

HOME = MIKE TEST1 > MIKE TEST A Search Documents

April 13, 2011 01:23

D CAPTIVATE_mousedcik.gif BEFH
PM EDT

April 18, 2011 0237

EI My Groups Test 2.xs [ Jp—

El Edit Properties

3. In the Edit Properties window, select the Require Approval check box. The Add
Approvers option displays.
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Secure File Exchange

Folder Actions Adrmin Help View: Al Documents 3

HOME > MIKE TEST1 > MIKE TEST A > CAPTIVATE_MOUSECLCIK.GIF

|| EDIT PROPERTIES

Name:

CAFTIVATE_mouseccik.gif

Description:

¥ Require approval Changes to files(s) are subject to approval '

i
Add Approvers

O Effecl:iveﬂates iiewr 51 TN this filﬁ z.rithin the daEﬁ EEEE ipeciﬁed 3‘ )
S - & o

If the folder to which a file is uploaded already requires approval
workflow, the uploaded file will require approval - it 'inherits' the
requirement from the folder. If this is the case, the “Require Approval”
check box is grayed out and you cannot change the approval requirement.

4. Click next to Add Approvers. The User Directory window displays.
a. Type the name (or partial name) of the users you want to assign as item
approvers in the Type in name field.
b. If you want o restrict your search to individual users, click the Include
drop-down arrow and select Users from the list.
c. Click Find. The screen refreshes, and the search results display.
d. Select the check box of each user you want to designate as an
approver. The users' names display in the Selected People box.
e. Click OK. The User Directory window closes and the selected approvers
display in the Edit Properties window Add Approvers list.
5. Click OK. The screen refreshes, and a message confirming the updated properties
displays.
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Secure File Exchange

Folder Actions  Admin | Help | View: Al Documents

“CAPTIVATE_mousecicik.gif* properties have been UPDATED ! |

HOME > MIKE TEST1 = MIKE TESTA |Search Documents

NAME STATUS SIZE TYPE MODIFIED DATE L
April 18, 2011 01:05

[ CAPTIVATE mousecicik gif IIEEH 43KE gif 4
PM EDT
April 18, 2011 10:20

@ My Groups Test 2.x1s [0 18KB  xls 4
AM EDT

RESULT:

You have successfully required approval on a file.
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Restoring a Previous Version

1. Navigate to the file you want to return to a previous version..
2. Click the drop-down arrow at the far right of the file name.

Where is the drop-down arrow?

Folder Actions Admin Help View: Al Documentz
HOME > A_MIKETEST _FOLDER Search Documents

) April 20, 2011 02:48
UU:I:E::?'::-.: [HEH!] —r e " &
d Cut PM EDT

[ Copy

L{-} Download
i@ Delete

Woaorkflow 2

Favorites & Alekts

Reports b |[EF WVersion History
T Audi
View Properties LI B

|
L| Edit Properties

[98)

Click Reports -> Version History. A list of the file versions displays.
4. Click the drop-down arrow at the far right of the version number to which you
want to restore the file

Where is the drop-down arrow?

77



Secure File Exchange User Guide

Secure File Exchange

Folder Actions | Admin @~ Help | View: Al Documents

HOME = A_MIKETEST_FOLDER = UPLOADDEMO.TXT

VER=# COMMENTS APPROVER MODIFIED BY MODIFIED DATE
ssatraining April 19, 2011 12:55
1.0
oz EDT
added new line for a version April 20, 2011 0244
1.1 s Erik Johnson
D Restore | EDT
April 20, 2011 02:446]
1.2 |D View ,ﬂ'r.-. |th|=_lr varsion Erik: Johnson
L) EDT

oo

5. Click View and follow the prompts to open the file. Verify that the version is the
one to which you want to restore the file. If the file contents are not what you
want, repeat steps 4 and 5 until you find the correct version.

6. Click the drop-down arrow at the far right of the version number to which you
want to restore the file.

Secure File Exchange

Folder Actions | Admin | Help | View: Al Documents

HOME = A_MIKETEST_FOLDER > UPLOADDEMO.TXT

VER# COMMENTS APPROVER MODIFIED BY MODIFIED DATE
ssatraining April 19, 2011 12:
1.0
oz EDT
added new line for & version April 20, 2011 02:
1.1 Erik Johnson
|D Restore | EDT
[] view April 20, 2011 02
1.2 ther versiocn Erikk Johnson -

o
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7. Click Restore. The file is restored to the selected version.
a. If approval is not required, the file is restored in the Checked Out state.
Perform the steps for Checking In a File to publish the restored version.
b. If approval is required, the file is restored in the Draft state. Perform the
steps for Submitting a Draft for Approval. When the file is approved, it
will become available to SFX users.

When you check in the file, the restore becomes a new version. For
example, if a file has versions 1.0, 1.2, and 1.3, and you restore the file to
version 1.2, the 1.2 contents restore will be tracked as version 1.4.

RESULT:

You have successfully restored a previous version.
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Searching for a File

1.

No matter where you are within the SFX repository when you conduct a
search, the search is performed on the entire repository. Searches are not
limited to files and subfolders in your current location.

Type search criteria in the search box. Search criteria can
include: words in the file title, keywords, document type
(such as doc or PDF), etc.

Where is the search box?

Secure File Exchange

Wiew: Al Documents

Folder Actions | Admin | Help |

|E‘Htersearch terms |

HOME

MAME STATUS SIZE  TYPE MODIFIED DATE |
April 19, 2011 12:55

E5l A_miketest_folder Falder 4
PM EDT
April 18, 2011 11:54

[Z5] chris122 Folder
AM EDT

2. Click the magnifying glass icon to start the search. The

80
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Secure File Exchange

Folder Actions ~ Admin | Help | (4]Back View: Al Documents

Searched for upload Found 7 results: |

SEARCH RESULTS

upload

NAME STATUS SIZE TYPE MODIFIED DATE LOCATION
September 28, 2010

D Uploaddemnao. bt 1KB bt Home/SidzhouwD
09:25 PM EDT
March 11, 2011 04:31

D Uploaddemao. bt 1KB bt Homelchris123
AMEST
April 20, 2011 03:12

D Uploaddemc.td G 1KB et Home'd_miketest
PM EDT

Search results are for approved items only. If a document is pending
approval, it is not rendered in the search results.

3. From the search results, you can:
a. View or download a file by clicking its link in the Name column.

b. Navigate to a file by clicking its hyperlink in the Locations column.

RESULT:

You have successfully searched for a document.
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Setting Effective Dates

1.
2.

W

82

Navigate to the file or folder for which you wish to set dates.
Click the drop-down arrow at the far right of the file.

Folder Actions Admin Help View: All Documents

Edit Properties

HOME = MIKE TEST1 > MIKE TEST A Search Documents

- April 13, 2011 01:23
D23=TI.3TE_"':,se:I:i- gif EEEH e
PM EDT
April 18, 2011 0237
EI My Groups Test 2.xs [ e
AM EDT

& Delete

Fawvorites

Reports

E View Propertie
El Edit Properties

Click Edit Properties.
Select the Effective Dates check box, and use the calendar icons to set the start
and end date that this file will be available to viewers. Once the end date is
reached, the file will no longer be available to users with only the Viewer role, but
will remain available to all other user types.

a. Click =2 to select the viewing availability Start Date.

b. Click =2 to select the viewing availability End Date.
Click OK.

@ Effective dates specify the date range for which a file is available to users
with only the Viewer role.



Working with Files

The effective dates can be changed or turned off by the file or folder
owner.

The dates do not limit file access by users with other roles.

RESULT:

You have successfully set effective dates.
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Submitting a Draft for Approval

1.

@ This procedure applies only to files that require approval workflow.

You cannot submit a file for approval unless it is in Draft status. Perform

a File Update in order to put a file in Draft status.

Navigate to the draft file you want to submit.

2. Click the drop-down arrow at the far right of the file name.

Where is the option?

Folder Actions Admin Help

Submit the

updated file
HOME > MIKE TEST1 > MIKE TEST A

D CAPTIVATE_mousedcik gif EEEH

gl My Groups Test 2.xis

Waorkflow 2

Favorites & Alebts

Reports b

View Properties

Edit Properties

i
2

—ifLIndo Check out

View: Al Documents

Search Documents

April 18, 2011 01:13
PM EDT
April 18, 2011 10:20
AM EDT

ub%ﬁ:r Approv

3. From the workflow option, click Submit for approval. The Submit for Approval

84
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Secure File Exchange

Folder Actions | Admin | Help | View: Al Documents

HOME > MIKETEST1 > MIKE TEST A > CAPTIVATE_MOUSECLCIK.GIF

@ SUBMIT FOR APPROVAL:

USER COMMENTS STATE DATE

Please enter comments:

Flease review and approve the new callout AI

=
oK canceL

4. Enter comments for the approver.
5. Click OK. The file's status is changed to the Pending state. You will receive
email notification of the approval decision.

RESULT:

You have successfully submitted a draft for approval.
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Canceling an Approval Request for a Draft

1. Navigate to the Pending file whose submission for approval you want to cancel.
2. Click the drop-down arrow at the far right of the file name.

Where is the option?

Folder Actions Admin Help

View: AllDocuments

Search Documents

HOME > MIKE
i Workflow == Undo... '

April 19, 2011 01:54
FM EDT

April 20, 2011 04:00

R

|D CAFTIVATE_mousedcik. gif

Copy
D CAFTIVATE_mousedide-ssa.gif [

ownload

My Groups Test 2.xls

@ 554 _approval_required.doc [EEH

Favorites

Reports

fi) View Properties
E| Edit Properties

PM EDT
April 20, 2011 02:20
PM EDT
April 18, 2011 02:03
PM EDT

April 19, 2011 08:47

@ Undo Chedk out
T

|
B Unda Sub@; Appr
& Approve

D Reject

3. From the workflow option, click Undo submit for approval.

4. The file is returned to the Draft state.

RESULT:

You have successfully cancelled an approval request for draft.

86




Working with Files

Updating a File

This procedure assumes you have downloaded and modified a file, and you want to
update it on SFX.

@ You create or edit files outside of SFX, using an appropriate software program.

1. Navigate to the folder that contains the file you want to update.

| Folder Actions | Admin Help View: Al Documents e
Mew Folder
[2] Upload File 1 = MIKETEST A Search Documents

@ Download files as
April 18, 2011 01:13

Favorites and Merpicik gif [EI Draft 43KE qif E'g
PM ECT
' Cut April 18, 2011 10:20
% = 18KB  xls = 2
|:|‘_] Copy AM EDT

& Delete
@ View Properties
B Edit Properties

2. From the Folder Actions menu, click Upload File.
3. Click Browse. View file name restrictions >>>

@ Note: The following special characters are not allowed in file names:
/| & :%+7? 5 *

We recommend you do not include spaces in the names of files
stored on SFX.
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Browse to and select the file you want to upload.

Optional:Set approval or effective dates, descriptions or keywords, as required.
For details, refer to Additional Options when Uploading a File.

Click OK. A confirmation dialog similar to the following is displayed.

Confirm file(s) replace %

wiould you like to replace the existing file(s)?
TearnRoorn (TR ).rmrmap

[ (9] 4 ” Cancel ]

k.

Click OK. The file is uploaded and a new version is created.

a. If approval is not required, your uploaded file is set to Checked Out
status. Perform Checking in a File (no approval) when you are ready to
make the file available to other users.

b. If approval is required, your uploaded file is set to Draft status. Perform
Submitting a Draft for Approval when you are ready to make the file
available to other users.

RESULT:

You have successfully updated a file.
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Assigning a Fax Number to a New Folder

@ This task can be performed only by an SFX Administrator.

If you see 'no fax' in the Fax Number drop down menu, one of the
following conditions exists:

e Your organization has not yet purchased fax functionality.
e Your fax functionality is not set up.
e All of your purchased fax numbers are used.

Contact your Covisint sales representative for details.

1. Navigate to the folder in which you wish to create a new folder or click HOME in
the navigation path to create a top-level folder.

2. From the Folder Actions menu, click New Folder. The Create Folder fields
display.

Secure File Exchange
m Admin View: Al Documentz
=] Mew Folder -
Q Upload File \“j ‘Search Documents
B Download fles as STATUS SIZE TYPE MODIFIED DATE
March 11, 2011 03:46
Favarites and Sker Folder &3
AM EST
| March 11, 2011 05:01
dﬁ Folder =2
|:|_] Copy AM EST
E:I Paste S May 27, 2009 07:57 -
FM EDT
@ Delste April 11, 2011 11:50
_ _ Folder &3
@ Yiew Properties AM EDT
& Edit Properties Movember 13, 2008
D - Folder =2
02:08 FM EST
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3. Inthe Create Folder fields:

Secure File Exchange

Folder Actions Admin Help View: All Documents

HOME

|| CREATE FOLDER

Name:

Fax number:
P - |

Draescription:

= N

(I Require approval Approval settings on this folder override existing approval settings on files/fd

OK CANCEL

FOR ALL FILES WITHIN THIS FOLDER:

vithin this folder &

a. Type the name of the folder.

We recommend that you include the fax number assigned to this folder in
the Folder name field.

b. From the Fax number drop down menu, select the fax number you want to
assign to this folder. Once this number is assigned, it will be removed
from the drop-down menu.

c. Type a description of the folder.

We recommend that you include the fax number assigned to this folder in
the folder description field.
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4. Optional: You can require approval on any updates made to items in this folder by
selecting the Require approval check box. If you do not require approval,
proceed to step 5.

Checking this box activates approval workflow. If the check box is
selected, all files faxed to this folder require approval before they are
made available to other users.

a. Click @ nextto Add Approvers. The User Directory window displays.

b. Search for and select each user and group you want to add as approvers of
this item.
Note: You can select multiple approvers, but only one approval is required
for publishing.

c. Click OK to dismiss the User Directory window and populate approver
names for the new folder.

5. Click OK.

RESULT:

You have successfully assigned a fax number to a new folder. ltems faxed to this
folder are stored in .PDF format. If approval is required on this folder, faxed items
will remain in the Pending state until they are approved.
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Assigning a Fax Number to an Existing Folder

@ This task can only be performed by an SFX Administrator.

When you assign a fax number, it is removed from the list of available fax
numbers.

If you see 'no fax' in the Fax Number drop down menu, one of the
following conditions exists:

e Your organization has not yet purchased fax functionality.
e Your fax functionality is not set up.
e All of your purchased fax numbers are used.

Contact your Covisint sales representative for details.

1. Navigate to the folder to which you want to assign a fax number.
2. Click the drop-down arrow at the far right of the folder name.

Where is the drop-down arrow?
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Secure File Exchange

Folder Actions Admin Help View: All Documentz
HOME ‘Search Documents
STATUS SIZE T™WPE MODIFIED DATE -~
N April 19, 2011 0828
5| Mike Test 1 Ider &=
& Cut AM EDT
- 0 Copy April 18,2011 11:54 |
2a| chris123 lder
i Paste AM EDT
April 11, 2011 1150
B Agril11 Q Download files as .}, 4., " |
AM EDT
& Delete
March 23, 2011 04:42 esl
| Testin i |dar
= 8 Favorites & Alepts PM EDT
: March 18, 20111 01:24
s stg- Q View Properties Idler ==
@ Edit Propﬁﬁles gt
) March 18, 20111 01:12
[ZE z-Linda-Test Folder
PM EDT

W

Click Edit Properties. The Edit Properties fields display.

4. From the Fax number drop down menu, select the fax number you want to assign
to this folder.

5. Optional: Edit the folder name to include the fax number assigned to this folder.

We recommend that you include the fax number assigned to the folder in this
description field.

6. Optional: Edit the description of the folder to include the fax number assigned to
this folder. We recommend that you include the fax number in this description
field.

7. Edit approval requirements as required. Refer to Creating a Folder for approval
requirement details and work steps.

8. Some users can edit the owner of the file. (Refer to Changing File or Folder
Owners for detailed work steps.

9. Click OK.

10. Optional: Modify access permissions to the file or folder by following the steps in

the section entitled Modifying Access Rights.

RESULT:

You have successfully a assigned a fax number to an existing folder. ltems
faxed to this folder are stored in .PDF format. If approval is required on this
folder, the faxed item will remain in pending state until approval has been
granted.
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Changing File or Folder Ownership

This task can be performed only by an SFX Administrator.

A file or folder can have only one owner.

1. Navigate to the file or folder whose owner you want to change.
2. Click the drop-down arrow at the far right of the file/folder name.

Where is the drop-down arrow?

Folder Actions Admin Help View: All Documents

Edit Properties

HOME = MIKE TEST1 > MIKE TEST A Search Documents

April 13, 2011 01:23
D23=TI.3TE_"':,se:I:i- gif EEEH =2
PM EDT
April 18, 2011 0237
EI My Groups Test 2.xs [ =2
AM EDT

El Edit Properties

3. Click Edit Properties. A list of file/folder properties is displayed.
4. Click @ nextto Change Owner. The User Directory window displays.
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Secure File Exchange

Folder Actions Admin Help View: Al Documents

HOME > MIKE TEST1 > MIKE TEST A > CAPTIVATE_MOUSECLCIK.GIF

|| EDIT PROPERTIES

Name:

CAPTIVATE_mousedcik gif

Drescription:

Keywords:

r Require approval
r Effective dates Vig

¥ Uncheck this box

COORDINATOR:
COLLABORATOJY Bead, Debby :Chrysler, Tester Three ;Deed, Dians
VIEWER: Cj er Portal: Services for Chrysler/EVERYOMNE; Chrysler Portal: Services for Chrysler Fina
Services/ B\ ONE
DWNER,
@ Change Cwner
'@' Jo

OK CANCEL

a. Type the name (or partial name) of the user you want to assign as the item
owner in the Type in name field.

b. If you want to restrict your search to individual users, click the Include
drop-down arrow and select Users from the list.

c. Click Find. The screen refreshes, and the search results display.

d. Select the check box of the user you want to designate as the item
owner. An item can have only one owner. The user's name displays in the
Selected People box.

e. Click OK. The User Directory window closes and the owner selection
displays in the Edit Properties window.

5. Click OK. The previous owner is removed from the item's ownership and the new
owner is assigned.
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RESULT:

You have successfully changed ownership of a file or folder.
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Copying a File or Folder to a New Location

1. Navigate to the file or folder you want to copy.
2. Click the drop-down arrow at the far right of the file or folder name.

Where is the drop-down arrow?
==
Folder Actionsz Help View: Al Documents
HOME > A_MIKETEST_FOLDER Search Documents
April 19, 2011 12:56
Mike Test A .~ Her ==
& Cut FM EDT
[y Copy April 19, 2011 12:55
Uploaddemo.ba I &=
D {b FM EDT

@ Download files as .|
& Delete

Favorites & Alekts

@ View Properties
B Edit Properties

3. Click Copy. The file or folder (with its files and subfolders) is copied to the
clipboard.

4. Navigate to the target location.

5. From the Folder Actions menu, click Paste.
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eeq
Folder Actionz Help View: Al Documentz
Mew Folder
[Z] Upload File T_FOLDER Search Documents
@. Download files as
Favmites and Mer S April 189, 2011 12:581 o
PM EDT
4 Cut

0 copy
Eﬁ Paste \“i')

& Delete

@ View Properties

B Edit Properties

Copying files or folders creates duplicate items. Changes to a file or
folder in one location do not apply to copies in other locations.

RESULT:

You have successfully copied a file/folder to a new location.
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Creating a New Folder

1. Navigate to the folder in which you wish to create a new folder (Or click HOME
in the navigation path to create a top-level folder).

2. From the Folder Actions menu, click New Folder. The Create Folder fields
display.

Where is the option?

Secure File Exchange

ﬁ| Admin | Helg o View: Al Documents

(=] Upload File ‘Search Documents
[ Download files as SIZE TYPE MODIFIED DATE
March 11, 2011 03:48
Favarites and ler Folder &3
AM EST
a Cut March 11, 2011 05:01
Folder (===
0y copy AMEST
May 27, 2002 0757
@ Faste Folder e (==
FPM EDT
& Delete . .
April 11, 2011 11:50
. ) Folder ==
@ View Properties AM EDT
Edit Properties Meovermnber 13, 2008
@ : Folder ==
02:08 FM EST

3. In the Create Folder fields:
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Secure File Exchange

Folder Actions Admin Help View: Al Documentz

HOME

|| CREATE FOLDER

MName:

Fax number:
T _- |

Drescription:

= N

r Require approval Approval settings on this folder override existing approval settings on files/fd

OK CANCEL

FOR ALL FILES WITHIN THIS FOLDER:

within this folder &

a. Type the name of the folder.
b. Type a description of the folder.
4. Click OK.

RESULT:

You have successfully created a folder. Next, you may want to:
- add a file to the folder

- require approval on the folder (when available)

- modify access rights to the folder

101



Secure File Exchange User Guide

Deleting a Folder

102

You must be the folder owner (or have an appropriate SFX role) to delete
a folder. A deleted file or folder is moved to the SFX Repository Recycle
Bin. Only an SFX Administrator can restore files that have been moved

to the recycle bin.

1. Navigate to the folder you want to delete from SFX.
2. Click the drop-down arrow at the far right of the folder name.

Delete the folder

Folder Actions Help Mike Test A

HOME > A_MIKETEST_FOLDER

Miks Test A

Favorites & Alekts

@ View Properties
E| Edit Properties

3. Click Delete. A deletion confirmation dialog displays.
4. Click Yes to confirm the deletion.

e

View: Al Documents

Search Documents

April 19, 2011 12:58

= PMEDT

April 19, 2011 12:55

FM EDT

5. The folder, along with all its contents and subfolders, is deleted. The screen

refreshes and displays an update confirmation.
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Secure File Exchange

Folder Actions  Help | View: Al Documents

"Mike Test A" has been DELETED!

MAME STATUS  SIZE  TYPE MODIFIED DATE

D Uploaddeme.td 1KEB
PM EDT

HOME = A_MIKETEST_FOLDER |Search Documents

April 19, 2011 12:55

RESULT:

You have successfully deleted a file.
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Downloading a Folder and its Files

This task does not download subfolders and their contents. You can
perform this task only to download the files that are stored directly under
a folder. For example, If My Folder I contains only folders, you cannot
download My Folders 1, even if its subfolders contain files.

You can download a folder and the files stored directly under it as a zip file.

1.

W

Navigate to the folder you want to download.
Click the drop-down arrow at the far right of the file name.

Where is the drop-down arrow?

Secure File Exchange

Folder Actions Admin Help View: Al Documents

HOME |Search Documents
STATUS SIZE TYPE MODIFIED DATE -

April 13, 2011 12:49

[E5 Mike Test 1 =1 Calder &
dlf Cut PM EDT
Copy April 11, 2011 11:50
G5l Cov QA - April11 ED Ider &=
@ Paste AM EDT
March 23, 2011 D4:43
[55) Testing PUP-2185 [} Download files as Jider &=
FM EDT

& Delete

March 18, 2011 01:24
[Z5) Stg-Chrysler_SFX_MewFolder-laya-2-18-2011 Ider &=
Favorites & Alepts PM EDT

. March 18, 2011 01:12
[Z3 z-Linda-Test View Properties | iger ==

PM EDT
@‘ Edit Properties

March 11, 2011 05:01

Click Download files as...

The system generates a zip file of the files within the folder and prompts you do
open or save the file. Click Save.

Navigate to the location to which you want to save the generated zip file and click
OK. The zip file is saved.

RESULT:
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You have successfully downloaded a folder and its contents.
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Editing File or Folder Properties

You must be the item owner or have the required permissions to perform
this task.

1. Navigate to the file or folder whose properties you want to edit.
2. Click the drop-down arrow at the far right of the file/folder name.

Where is the drop-down arrow?

- _j Paste
Secure File Exchange
Q Download

& Delete
Folder Actions | Help | View: Al Documents
Workflow 2
HOME > MIKE TEST 1 Favorites & Alekts |Search Documents

e . EE—

Reports
April 19, 2011 01:54

5| Mike Test A er &=
= Q View Properties FM EDT
[ Edit Properties April 19, 2011 09:22
|@ SSA_no_spproval.doc OEEH 1 &2
g AM EDT

3. Click Edit Properties. The Edit Properties window displays.
4. Edit the properties as desired.
a. Edit approval requirements as desired. (Refer to the section entitled
Removing Approval Requirements from a File or Folder or Requiring
Approval on a File for further details)
b. Some users can change the file owner. See Changing File / Folder Owners
for details.
c. Optionally, modify access permissions to the file or folder by following
the steps in the section entitled Modifying Access Rights.
5. Click OK.

RESULT:

You have successfully edited the properties of a file or folder.
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Modifying Access Rights to a File or Folder

@ Files and folders inherit access rights from the folder in which they reside.
Users with appropriate privileges can modify access rights.

Performing these steps to a folder applies to the folder, and to its
subfolders - unless you further modify the subfolders.

Performing these steps for a file applies only to the item with which you
are working and does not impact access rights to other files.

1. Navigate to the file or folder whose access rights you want to modify. (How do

I navigate to a file or folder?)
2. Click the drop-down arrow at the far right of the file/folder name.

Where is the drop-down arrow?

Folder Actions Admin Help View: All Documents

Edit Properties

HOME = MIKE TEST1 > MIKE TEST A Search Documents

April 13, 2011 01:23
D23=TI.3TE_"':,se:I:i- gif EEEH =2
PM EDT
April 18, 2011 0237
==

EI My Groups Test 2.xs [ Jp—

El Edit Properties
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3. Click Edit Properties. The Edit Properties window displays.

Secure File Exchange

Folder Actions | Help | View: Al Documents

HOME > MIKE TEST1 » TEST2-INHERITANCE

|| EDIT PROPERTIES

Name:

|T.=_~.-r2-inhaitanue
Description:

Tahorna e ru A A A

&
m
1]
1l
@.
i
@

Upload Custom Icon:

Select an icon:

Submit

r Reguire approval Changes to files(s) are subject to approval L]

¥ Uncheck this box to remowve inherited access controls from the folder above L2
FOLDER ADMINM:

COORDINATOR: Chrysler, Tester Two

COLLABORATOR: Deed, Debby ;Deed, Diane ;Chrysler, Tester Three
CONTRIBUTOR: View, Victor ;02, ssatraining ;Seashell, Sally ;Chrysler, Tester Four

VIEWER: Chrysler Portal: Services for Chrysler/EWVERYONE; Chrysler Portal: Services for Chrysler Finan
Services/EVERYOMNE

DWHNER: ssatraining 02

OK CANCEL

4. Clear the check box next to Uncheck this box to remove inherited access
controls... A confirmation dialog displays.
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5. Click Yes to remove inherited access controls for the item. The Edit
Properties refreshes and displays the set of properties you can modify
for the item.
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Secure File Exchange

Folder Actions |Heb | View: Al Documents

HOME = MIKE TEST1 = TESTZ-INHERITANCE

|| EDIT PROPERTIES

Name:

|TrEt’2-i nheritance

Description:

Tahoma B I U AANA Y EEEgEEE

Upload Custom Icon:

Select an icon:

Submit

r Require approval Changes to files(s) are subject to approval L2
[ check this box to inherit access controls from the folder above &
n FOLDER ADMIM:

E COORDINATOR:
@Ad d Members

'@ Tester Two

H COLLABDRATOR:
@Ad d Members

il Deed, Debby , [ Deed, Diane

E CONTRIBUTOR:
@Ad d Members

il View, Victor , il 02, ssatraining , [ Seashell, Sally

ﬂ VIEWER:
@Ad d Members

OWMNER: ssatraining 02

Ok CANCEL
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6. If you want to provide access to members, click @ next to Add Members in the
role type to which you want to add users. The User Directory window displays.

a.

b.

C.
d.

.

f.

Type the name (or partial name) of the user or group you want to add in
the Type in name field.

If you want to restrict your search to individual users, click the Include
drop-down arrow and select Users from the list.

Click Find. The screen refreshes, and the search results display.

Select the check box of the users and groups you want to add. The users
display in the Selected People box.

Repeat steps a through d as required until you are finished adding users.
Click OK. The User Directory window closes and the added members
display in the Edit Properties window.

7. 1f you want to remove access to the file or folder, click I, the wastebasket icon,

next to the users and groups whose access you want to remove.
8. Click OK.

RESULT:

You have successfully modified access rights on an item.
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Moving a File or Folder with Cut

@ You must be the file or folder owner or have an appropriate role to move
a file or folder using Cut.

1. Navigate to the file or folder you wish to move.
2. Click the drop-down arrow at the far right of the file name.

Where is the drop-down arrow?
e
Folder Actions Help View: Al Documents
HOME > MIKE TEST1 > TESTZ2-INHERITANCE Search Documents
April 18, 2011 02:18
test3-inheritance T = der ==
d Cut PM EDT
|:_| Copy

@ Download files as .1
@ Delete

Favorites & Alekts

@ View Properties
E/ Edit Properties

3. Click Cut.
4. Navigate to the location to which you want to move the file or folder..
5. From the Folder Actions menu, click Paste.

Where is the option?
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eeq
Folder Actionz Help View: Al Documents
Mew Folder
[Z] Upload File »T_FOLDER Search Documents
E} Download files as |
Favarites and Aler Folder April 189, 2011 12:581 o
PM EDT
4 Cut

0 copy
D Paste \“i')

& Delete

@ View Properties
B Edit Properties

RESULT:

You have successfully cut and pasted a file or folder.
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Requiring Approval on a Folder

If your SFX Administrator configures all items in the repository to require approval,
approvers are established at the repository level for all folders and files within the
repository. You cannot turn off approval workflow for your items, and you cannot select
your Own approvers.

If approval is not required at the top repository level, you can require approval on folders
for which you are the owner or administrator. Complete the following steps to require
approval on a folder.

1. Navigate to the folder for which you want to require approval.
2. From the folder drop down menu, click Edit Properties. The Edit Properties
window displays.

oc
Folder Actions Help View: Al Documents
HOME = MIKE TEST1 > TEST2-INHERITANCE Search Documents
. April 19, 2011 02:18 r
e & Cut . PMEDT

E_] Copy

@ Download files as .1
i@ Delete

Favorites & Alepts

@ View Properties
El Edit Prpperties

3. Select the Require approval check box. The Add Approvers option displays.
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Secure File Exchange

Folder Actions | Help View: Al Documents 3

HOME > MIKE TEST1 » TEST2-INHERITANCE > TEST3-INHERITANCE

test2-inheritance

Description:
Tahoma = === @ iz B

Upload Custom

Submit

7 Require approval Changes to files(s) are subject to approval @

a Add Approvers

¥ Uncheck this box to remove inheritad access controls from the folder above @
FOLDER ADMIN:

COORDINATOR: Chrysler, Tester Two

COLLABORATOR: Deed, Diane ;Deed, Debby

CONTRIBUTOR: View, Victor ;02, ssatraining ;Seashell, Sally

VIEWER: Chrysler Portal: Services for Chrysler/EVERYONE; Chrysler Portal: Services for Chrysler Financial
Sarvices/EVERYONE

OWHMNER: ssatraining 02

OK CANCEL

4. Select the Require approval check box. The Add Approvers option is enabled.

5. Click &) next to Add Approvers. The User Directory window displays.
a. Type the name (or partial name) of the user or group you want to add
as approvers in the Type in name field.
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b. If you want to restrict your search to individual users, click the Include
drop-down arrow and select Users from the list.

c. Click Find. The screen refreshes, and the search results display.

d. Select the check box of the users and groups you want to add as
approvers. The users display in the Selected People box.

e. Repeat steps a through d as required until you are finished adding
approvers.

f. Click OK. The User Directory window closes and the approvers display in
the Add Approvers field.

6. Click OK. The screen refreshes, and a message confirming the updated properties
displays.

RESULT:

You have successfully required approval on a folder.
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Removing Approval Requirement from a Folder or File

If your SFX Administrator configures all items in the repository to require approval,
approvers are established at the repository level for all folders and files within the
repository. You cannot turn off approval workflow for your items, and you cannot select
your Own approvers.

When approval is not turned on at the top repository level, it can be required by the folder
or file owner or administrator. If you are the owner or administrator, you can remove
previously configured approval requirements. Complete the following steps to remove
approval requirements on a folder or file.

1. Navigate to the folder or file for which you wish to remove approval
requirements.

2. From the item drop down menu, click Edit Properties. The Edit Properties
window displays.

Folder Actions Admin Help View: Al Documents b
HOME > MIKETEST1 > mike TesTaf  Edit Properties Search Documents
CARTIVATE dcikgif CEE - April 13, 2011 01:23 =
CAPTIVATE_mousedcik gi . L=
O - . h FM EDT et
E‘J‘ pl' Aot . 0-97
i April 18, 2011 0837 -
@ My Groups Test 2.xls TN =2 &
AM EDT
@

B Edit Properties

3. Clear the Require approval check box.
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Secure File Exchange

Folder Actions | Help View: Al Documents 3

HOME > MIKE TEST1 > TEST2-INHERITANCE > TEST3-INHERITANCE

test2-inheritance
Description:

| Tahorna ;I |

W
i
i
&
i
&

Upload Custom

Submit

7 Require approval Changes to files(s) are subject to approval @

a Add Approvers

¥ Uncheck this box to remove inheritad access controls from the folder above L2
FOLDER ADMIN:

COORDINATOR: Chrysler, Tester Two

COLLABORATOR: Deed, Diane ;Deed, Debby

CONTRIBUTOR: View, Victor ;02, ssatraining ;Seashell, Sally

VIEWER: Chrysler Portal: Services for Chrysler/EVERYONE; Chrysler Portal: Services for Chrysler Financial
Sarvices/EVERYONE

OWHMNER: ssatraining 02

OK CANCEL

4. Click OK. The screen refreshes, and a message confirming the updated properties
displays.
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RESULT:

You have successfully removed approval requirements from a folder or file.
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Assigning Users to Roles in SFX Repository

@ This task can only be performed by an SFX Administrator.

Caution: Changes made to the Repository Settings impact everything
from the top-level Home folder down. For example, if you add a user or
group to the Administrator role, that user or group becomes an
Administrator for the entire SFX instance.

1. From the Admin menu, click Repository Settings.

Where is the option?

Secure File Exchange [ >

Wiew: Al Documents

|Search Documents

_ Reports b STATUS  SIZE TYPE MODIFIED DATE

) March 11, 2011 03:46
[E5) chris123 Folder &3
AMEST

2. Click next to Add Members in the role type to which you wish to add users.
The User Directory window displays.
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Secure File Exchange

Folder Actions Admin Help View: ANl Documents

Access Lavel Add ADMIN Members

n ADMIN:

ﬁ Add Members

M@ Financial

m COORDINATOR:

ﬁ Add Members

'ﬂ Tester Two

m COLLABORATOR:

@ Add Members

m CONTRIBUTOR:

'@ Add Membaers

M Tester Four

ﬂ VIEWER:
'@ Add Mambers

M sServices for EVERYONE |

r Require approval

¥ Follaw file retantion palicy
Duration (in days) :

I Enforce axpiry within retention

Ok CANCEL

3. Search for and Select the people you want to add to the role for which you clicked
Add Members.



Administration

User Directory

Type in name Include

[test Jusers =l
HName Type Organization -

¥ Tester Fowr User

T Tester One User
F Taster Thraa Usar s
[T Tester Twe Usar
[~ Tester, Q& User _d

Selected People
@ Tester Four {0 Tester Three

“ Cancel

a. Type the name (or partial name) of the user or group in the Type in name
field.
b. If you want to restrict your search to individual users, click the Include
drop-down arrow and select Users.
c. Click Find. The screen refreshes, and the search results display.
d. Select the check box of each user or group you want to add to the selected
SFX role. Checked users display in the Selected People list.
e. Click OK. The User Directory window closes and the users you added
display in the appropriate role section under REPOSITORY
CONFIGURATION SETTINGS.
4. Repeat steps 2 and 3 for each role to which you want to add users.
5. Click OK. The SFX HOME page displays in your portal.

RESULT:

You have successfully added users to roles in SFX
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Emptying the Recycle Bin

124

@ This task can only be performed by an SFX Administrator.

You can permanently remove individual files from the Recycle Bin, or
you can completely empty it.

1. Click Recycle Bin from the View drop-down menu. The Recycle Bin window
displays.

Where is the View drop-down menu?

Secure File Exchange

View: Al Documentz

Search D¢ My Favorites

S S - - My Check Outs
. My Approvals

Folder Actions | Admin

All Documents

[Z5] A_miketest_folder N My Alerts
) Recycle Bin
118, ‘Wdiw}
[55] chris123 Folder #er

2. Select the check box of each item you want to permanently delete, or click &l to
select all documents in the recycle bin.



Administration

Secure File Exchange

Folder Actions  Admin | Help | [4Back View: Recycie Bin
RECYCLE BIN
ey Size Type Date LOCATION

April 13, 2011
W [ Mike Test A Folder Home/A_miketest folder
01:22 PM EDT

_ April 19, 2011
Wi [ Milee Test A Folder Home/financial 4 sub
12:59 PM EDT

March 18, 2011
| 5 ddeed 2 Folder Home
01:43 PM EDT

3. Click Delete. A deletion confirmation dialog displays.

Important: Once a file his deleted from the Recycle Bin, it cannot be
restored.

4. Click Yes to confirm the deletions. The screen refreshes, the selections are
deleted, and a deletion completed message displays.

RESULT:

You have successfully emptied the recycle bin.
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Managing the Admin Tab

From the Admin menu, you can view the following:

Where is the menu?

Secure File Exchange

Folder Actions Iimvp%l Help | View: |AII[}ul:uments |
e p—

. Repository Setting
HOME ,’3 System Settings |Search Documents @

m R = " S5TATUS  SIZE TYPE MODIFIED DATE LINK

April 19, 2011 12:55
5| A_miketest_folder Folder &=
A - PM EDT o

e Repository Settings - Add or Remove Users / Groups from the SFX repository.

e Overview - Reports on the total space used, number of folders, and number of
files.

e User Disk Space - Provides a report of the top 50 users with most disk space.

o Largest Files - Provides a report on the top 50 largest files.

e Most Accessed Files - Provides a report on the top 50 most accessed files.

e Auto-Loader functionality - if your organization has contracted for that option.
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Removing Approvers from Files or Folders

Refer to Modifying Access Rights to remove Approvers from a File or Folder
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Removing Users and Groups from Roles in SFX Repository

@ This task can only be performed by an SFX Administrator.

Caution: Removing Users and Groups at the repository level restricts
them from accessing anything within SFX.

If you want to remove users or groups from particular files or folders, do
not perform this procedure. Instead, modify access rights to the item.

1. From the Admin menu, click Repository Settings. The Repository Configuration
Settings window displays.

Where is the option?

Secure File Exchange [ >
View: |All Documents

HOME y ‘Search Documents
... s
[E5] chris122 Folder &3

2. Click the wastebasketicon @ next to the name of each user or group you want to
remove.
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Secure File Exchange

Folder Actions Admin Help

View: Al Documents

HOME

I,-Q REPOSITORY CONFIGURATION SETTING S
Access Level
n ADMIN:

@ Add Mambers

M relerndu ; Soartt ;T 3wl ey Crike

T ricasialy, Foan . [ Slo pebor; Tostor S

COORDINATOR:

@ Add Member

Click to delete

'@ er Twa

m COLLABORATOR:

@ Add Members

'@ Dee

[l Tester Three

E CONTRIBUTOR:

@ Add Members

i vie

@' Tester Four

ﬂ VIEWER:

@ Add Members

flif Portal: Services for EVERYCOME

M St 10 ¥ aSthrl § AR W ls il Wb TR el 11§ a2l 1P Pl | afbe] ¥ Ity % Ll % | S 1

(| Require approval

¥ Fallow file retention policy

Duration (in days) :
rl

I_EnF-:-n:e expiry within retention

OK

CANCEL

3. Click OK.

RESULT:
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You have successfully removed users from roles in SFX.
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Requiring Approval for all Files and Folders in SFX

@ This task can only be performed by an SFX Administrator.

1. From the Admin menu, click Repository Settings. The Edit Properties window
displays.

Where is the toolbar?

Secure File Exchange [ >

Folder Actions

View: Al Documents

HOME 2 System Setti |Search Documents

_ Reparts b STATUS  SIZE TYPE MODIFIED DATE

) March 11, 2011 03:46
[E5) chris123 Folder &3
AMEST

2. Select the Require approval check box. The Add Approvers option displays.

3. Click @ next to Add Approvers. The User Directory window displays.
a. Type the name (or partial name) of the users you want to assign as item
approvers in the Type in name field.
b. If you want o restrict your search to individual users, click the Include
drop-down arrow and select Users from the list.
c. Click Find. The screen refreshes, and the search results display.
d. Select the check box of each user or group you want to designate as an
approver. The names display in the Selected People box.
e. Click OK. The User Directory window closes and the selected approvers
display in the Edit Properties window Add Approvers list.
4. Click OK. The screen refreshes, and a message confirming the updated
properties displays.

RESULT:

You have successfully added approvers for all files/folders in SFX.
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Restoring from the Recycle Bin

Administration

@ This task can only be performed by an SFX Administrator.

1. Click Recycle Bin from the View drop-down menu.

Where is the View drop-down menu?

Secure File Exchange

Folder Actions | Admin

View:

All Documents

[E5] A_miketest_folder

[Z5] chris122

Search Dt

- My Approvals

All Documents
My Favorites
My Check Quts

My &lerts

» Recycle Bin E

2. Select the check box of each item you want to restore, or click & to select all

documents in the recycle bin.
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Secure File Exchange

Folder Actions  Admin | Help | [4Back View: Recyck Bin
RECYCLE BIN
ey Size Type Date LOCATION

April 13, 2011
W [ Mike Test A Folder Home/A_miketest folder
01:22 PM EDT

_ April 19, 2011
Wi [ Milee Test A Folder Home/financial 4 sub
12:59 PM EDT

March 18, 2011
| [E5 ddeed 2 Folder Home
01:43 PM EDT

3. Click Restore. The items are restored to the repository locations from which they
were deleted.

4. Click All Files from the View drop down menu to return to the folder structure.

RESULT:

You have successfully restored items from the recycle bin.
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Approving a Pending Draft File

This procedure assumes you have reviewed a draft file that is Pending approval, and you
are ready to approve it.

1. Click My Approvals from the View drop-down menu. The list of "Pending" files
for which you are an approver displays.

Where is the View drop-down menu?

Secure File Exchange

i P\II Documents

All Documents
My Favorites
SIZE My Check Outs

% My Approvals

[Z3] A_miketest_folder Folder FuEoT My Alerts

_Recycle Bin

April 18, 2
[Z3] chris123 Folder
AM EDT

2. Inthe list of Pending files, navigate to the draft file you wish to approve.

Secure File Exchange

Folder Actions | Admin | Help | Eﬂadc View: |My Approvals

MY APPROVALS

|Search Documents
HAME STATUS SIZE TYPE MODIFIED DATE LOCATION
Mowvember 02, 2007

@ LLC_DOCT... Pending OKB .doc Home/Deed1
10:03 AM EDT

[ |

3. Click the drop-down arrow at the far right of the file name.

135



Secure File Exchange User Guide

Where is the option?

Folder Actions Admin Help 4 [Back View: My Approvals

MY APPROVALS

Search Documents

E:] Copy

@ Download

Warkflow 3

Favorites & Alekts
E;'t, Undo Check out

Reports 2

View Properties

) ,
E/ Edit Properties @ HP%I:E

|=] Rejke

4. From the Workflow option, click Approve.
5. Click OK. The file is published and the Contributor is notified via email.

RESULT:

You have successfully approved a draft file.
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Modifying Access Rights to a File or Folder

@ Files and folders inherit access rights from the folder in which they reside.
Users with appropriate privileges can modify access rights.

Performing these steps to a folder applies to the folder, and to its
subfolders - unless you further modify the subfolders.

Performing these steps for a file applies only to the item with which you
are working and does not impact access rights to other files.

1. Navigate to the file or folder whose access rights you want to modify. (How do
I navigate to a file or folder?)
2. Click the drop-down arrow at the far right of the file/folder name.

Where is the drop-down arrow?

Folder Actions Admin Help View: All Documents

Edit Properties

HOME = MIKE TEST1 > MIKE TEST A Search Documents

April 13, 2011 01:23
D23=TI.3TE_"':,se:I:i- gif EEEH =2
PM EDT
April 18, 2011 0237
EI My Groups Test 2.xs [ =2
AM EDT

El Edit Properties

3. Click Edit Properties. The Edit Properties window displays.

137



Secure File Exchange User Guide

138

Secure File Exchange

Folder Actions | Help | View: Al Documents

HOME > MIKETEST1 = TEST2-INHERITANCE

|| EDIT PROPERTIES

Name:

|TEt2—il'l|‘ElitEll‘lEE
Description:

Tahoma ;I|BIE|A‘§:|&EP?|§

i
il
6
i
&

Upload Custom Icon:

Select an icon:

Submit

r Require approval Changes to files(s) are subject to approval 2]

1 Uncheck this box to remove inherited access controls from the folder above L2
FOLDER ADMIN:

COORDINATOR: Chrysler, Tester Two

COLLABORATOR: Deed, Debby :Deed, Diane :Chrysler, Tester Threa
CONTRIBUTOR: View, Victor ;02, ssatraining :Seashell, Sally :Chrysler, Tester Four

VIEWER: Chrysler Portal: Services for Chrysler/EVERYONE; Chrysler Portal: Services for Chrysler Finan
Services/ EVERYONE

OWNER: ssatraining 02

oK CANCEL

4. Clear the check box next to Uncheck this box to remove inherited access
controls... A confirmation dialog displays.

5. Click Yes to remove inherited access controls for the item. The Edit
Properties refreshes and displays the set of properties you can modify
for the item.



Workflow

Secure File Exchange

Folder Actions  Help |

View: Al Documents

HOME = MIKE TEST1 = TESTZ-INHERITANCE

|| EDIT PROPERTIES

Name:

|TrEt’2-i nheritance

Description:

Tahoma ;||BIE|A:A‘|A B2

W
]
i
&

Upload Custom Icon:

Select an icon:

Submit

r Require approval Changes to files(s) are subject to approval L2
[ check this box to inherit access controls from the folder above &
n FOLDER ADMIM:

E COORDINATOR:
@Ad d Members

'@ Tester Two

H COLLABDRATOR:
@Ad d Members

il Deed, Debby , [ Deed, Diane

E CONTRIBUTOR:
@Ad d Members

il View, Victor , il 02, ssatraining , [ Seashell, Sally

ﬂ VIEWER:
@Ad d Members

OWMNER: ssatraining 02

Ok CANCEL
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6. If you want to provide access to members, click @ next to Add Members in the
role type to which you want to add users. The User Directory window displays.

a.

b.

C.
d.

.

f.

Type the name (or partial name) of the user or group you want to add in
the Type in name field.

If you want to restrict your search to individual users, click the Include
drop-down arrow and select Users from the list.

Click Find. The screen refreshes, and the search results display.

Select the check box of the users and groups you want to add. The users
display in the Selected People box.

Repeat steps a through d as required until you are finished adding users.
Click OK. The User Directory window closes and the added members
display in the Edit Properties window.

7. 1f you want to remove access to the file or folder, click I, the wastebasket icon,

next to the users and groups whose access you want to remove.
8. Click OK.

RESULT:

You have successfully modified access rights on an item.



Workflow

Rejecting a Pending Draft File

his procedure assumes you have reviewed a draft file that is Pending approval, and you
are ready to reject it.

1. Click My Approvals from the View drop-down menu. The list of "Pending" files
for which you are an approver displays.

Where is the View drop-down menu?

Secure File Exchange

i P-\IDncuments
All Documents
My Favorites

SIZE My Check Outs

A_miketest_folder Folder e EoT | My Alerts

_Recycle Bin

April 18, 2
chris123 Folder
AM EDT

2. Inthe list of Pending files, navigate to the draft file you wish to approve.

Secure File Exchange

Folder Actions | Admin | Help | Eﬂadc View: |My Approvals

MY APPROVALS

|Search Documents

NAME STATUS SIZE TYPE MODIFIED DATE LOCATION
Mowember 02, 2007

@ LLC DOCT... Pending OKB .doc Home/Deed1 :
10:03 AM EDT

3. Click the drop-down arrow at the far right of the file name.
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Where is the option?

Folder Actions Admin Help 4 [Back View: |My Approvals

MY APPROVALS
Search Documents

Movember 02, 2007

EI:"_.-EH'__\.__-_NT be o d1
10:02 AM EDT

|:_| Copy

@ Download

Warkflow

Favorites & Alekts

Eét, Undo Chedk out

Reports

View Properties

L
Approve
E/ Edit Properties @ Aep

D Reject

4. From the workflow option, click Reject.
5. Optional: Type a rejection reason.
6. Click OK. The screen refreshes and the file is rejected.

RESULT:

You have successfully rejected a file.
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Removing Approvers from Files or Folders

Refer to Modifying Access Rights to remove Approvers from a File or Folder
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Removing Approval Requirement from a Folder or File

If your SFX Administrator configures all items in the repository to require approval,
approvers are established at the repository level for all folders and files within the
repository. You cannot turn off approval workflow for your items, and you cannot select
your Own approvers.

When approval is not turned on at the top repository level, it can be required by the folder
or file owner or administrator. If you are the owner or administrator, you can remove
previously configured approval requirements. Complete the following steps to remove
approval requirements on a folder or file.

1. Navigate to the folder or file for which you wish to remove approval
requirements.

2. From the item drop down menu, click Edit Properties. The Edit Properties
window displays.

Folder Actions Admin Help View: Al Documents b
HOME > MIKE TEST1 > mike TesT A jj| Edit Properties Search Documents
April 13, 2011 01:23
[) CAPTIVATE mousedicik gif EE " =2 &
FM EDT
pl' Aot . 0-97
_ April 18, 2011 08:27 =
@ My Groups Test Z.xls EIEEH =
AM EDT

B Edit Properties

3. Clear the Require approval check box.

144



Workflow

Secure File Exchange

Folder Actions | Help View: Al Documents E

HOME > MIKE TEST1 > TEST2-INHERITANCE > TEST3-INHERITANCE

[tatﬂ-inhetitanne
Description:

Tahorna ;I |

W
i
i
&
i
&

Upload Custom

5uhrni‘t|

Require approval Changes to files(s) are subject to approval @

a Add Approvers

Uncheck this box to remove inherited access controls from the folder above L2
FOLDER ADMIN:

COORDINATOR: Chrysler, Tester Two

COLLABORATOR: Deed, Diane ;Deed, Debby

CONTRIBUTOR: View, Victor ;02, ssatraining ;Seashell, Sally

VIEWER: Chrysler Portal: Services for Chrysler/EVERYONE; Chrysler Portal: Services for Chrysler Financial
Sarvices/EVERYONE

OWHMNER: ssatraining 02

OK CANCEL

4. Click OK. The screen refreshes, and a message confirming the updated properties
displays.
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RESULT:

You have successfully removed approval requirements from a folder or file.

146



Workflow

Requiring Approval for all Files and Folders in SFX

1.

@ This task can only be performed by an SFX Administrator.

From the Admin menu, click Repository Settings. The Edit Properties window
displays.

Where is the toolbar?

Secure File Exchange [ >

Folder Actions

View: Al Documents

HOME 2 System Setti |Search Documents

_ Reparts b STATUS  SIZE TYPE MODIFIED DATE

) March 11, 2011 03:46
[E5) chris123 Folder &3
AMEST

2. Select the Require approval check box. The Add Approvers option displays.

3. Click @ next to Add Approvers. The User Directory window displays.

a. Type the name (or partial name) of the users you want to assign as item
approvers in the Type in name field.

b. If you want o restrict your search to individual users, click the Include
drop-down arrow and select Users from the list.

c. Click Find. The screen refreshes, and the search results display.

d. Select the check box of each user or group you want to designate as an
approver. The names display in the Selected People box.

e. Click OK. The User Directory window closes and the selected approvers
display in the Edit Properties window Add Approvers list.

4. Click OK. The screen refreshes, and a message confirming the updated
properties displays.

RESULT:

You have successfully added approvers for all files/folders in SFX.
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Requiring File Approval

Workflow

If your SFX Administrator configures all items in the repository to require approval,
approvers are established at the repository level for all folders and files within the
repository. You cannot turn off approval workflow for your items, and you cannot select

your own approvers.

If approval is not required at the top repository level, and is not required at the folder
level by the folder owner or an administrator, you can require approval of files for which
you are the owner. Complete the following steps to require approval on a file.

1. Navigate to the file for which you wish to require approval.
2. From the file drop down menu, click Edit Properties. The Edit Properties

window displays.

Folder Actions

Admin Help

HOME > MIKETEST1 = MIKE TEST A

D CAPTIVATE_mousedcik.gif BEFH

EI My Groups Test 2.xls EEH

View: All Documents

Edit Properties

Search Documents

April 12, 2011 01:22
FM EDT
April 18, 2011 0227
AM EDT

El Edit Properties

3. In the Edit Properties window, select the Require Approval check box. The Add
Approvers option displays.
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Secure File Exchange

Folder Actions Adrmin Help View: Al Documents 3

HOME > MIKE TEST1 > MIKE TEST A > CAPTIVATE_MOUSECLCIK.GIF

|| EDIT PROPERTIES

Name:

CAFTIVATE_mouseccik.gif

Description:

¥ Require approval Changes to files(s) are subject to approval '

i
Add Approvers

O Effecl:iveﬂates iiewr 51 TN this filﬁ z.rithin the daEﬁ EEEE ipeciﬁed 3‘ )
S - & o

If the folder to which a file is uploaded already requires approval
workflow, the uploaded file will require approval - it 'inherits' the
requirement from the folder. If this is the case, the “Require Approval”
check box is grayed out and you cannot change the approval requirement.

4. Click next to Add Approvers. The User Directory window displays.
a. Type the name (or partial name) of the users you want to assign as item
approvers in the Type in name field.
b. If you want o restrict your search to individual users, click the Include
drop-down arrow and select Users from the list.
c. Click Find. The screen refreshes, and the search results display.
d. Select the check box of each user you want to designate as an
approver. The users' names display in the Selected People box.
e. Click OK. The User Directory window closes and the selected approvers
display in the Edit Properties window Add Approvers list.
5. Click OK. The screen refreshes, and a message confirming the updated properties
displays.
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Secure File Exchange

Folder Actions  Admin | Help | View: Al Documents

“CAPTIVATE_mousecicik.gif* properties have been UPDATED ! |

HOME > MIKE TEST1 = MIKE TESTA |Search Documents

NAME STATUS SIZE TYPE MODIFIED DATE L
April 18, 2011 01:05

[ CAPTIVATE mousecicik gif IIEEH 43KE gif 4
PM EDT
April 18, 2011 10:20

@ My Groups Test 2.x1s [0 18KB  xls 4
AM EDT

RESULT:

You have successfully required approval on a file.
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Requiring Approval on a Folder

If your SFX Administrator configures all items in the repository to require approval,
approvers are established at the repository level for all folders and files within the
repository. You cannot turn off approval workflow for your items, and you cannot select
your Own approvers.

If approval is not required at the top repository level, you can require approval on folders
for which you are the owner or administrator. Complete the following steps to require
approval on a folder.

1. Navigate to the folder for which you want to require approval.
2. From the folder drop down menu, click Edit Properties. The Edit Properties
window displays.

oc
Folder Actions Help View: Al Documents
HOME = MIKE TEST1 > TEST2-INHERITANCE Search Documents
. April 19, 2011 02:18 r
e & Cut . PMEDT

E_] Copy

@ Download files as .1
i@ Delete

Favorites & Alepts

@ View Properties
El Edit Prpperties

3. Select the Require approval check box. The Add Approvers option displays.
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Secure File Exchange

Folder Actions | Help View: Al Documents 3

HOME > MIKE TEST1 » TEST2-INHERITANCE > TEST3-INHERITANCE

test2-inheritance

Description:
Tahoma = === @ iz B

Upload Custom

Submit

7 Require approval Changes to files(s) are subject to approval @

a Add Approvers

¥ Uncheck this box to remove inheritad access controls from the folder above @
FOLDER ADMIN:

COORDINATOR: Chrysler, Tester Two

COLLABORATOR: Deed, Diane ;Deed, Debby

CONTRIBUTOR: View, Victor ;02, ssatraining ;Seashell, Sally

VIEWER: Chrysler Portal: Services for Chrysler/EVERYONE; Chrysler Portal: Services for Chrysler Financial
Sarvices/EVERYONE

OWHMNER: ssatraining 02

OK CANCEL

4. Select the Require approval check box. The Add Approvers option is enabled.

5. Click &) next to Add Approvers. The User Directory window displays.
a. Type the name (or partial name) of the user or group you want to add
as approvers in the Type in name field.
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b. If you want to restrict your search to individual users, click the Include
drop-down arrow and select Users from the list.

c. Click Find. The screen refreshes, and the search results display.

d. Select the check box of the users and groups you want to add as
approvers. The users display in the Selected People box.

e. Repeat steps a through d as required until you are finished adding
approvers.

f. Click OK. The User Directory window closes and the approvers display in
the Add Approvers field.

6. Click OK. The screen refreshes, and a message confirming the updated properties
displays.

RESULT:

You have successfully required approval on a folder.
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How Does the Auto Loader Functionality Work?

The Auto Loader feature is added SFX functionality that is available for purchase by
Covisint SFX customers. Contact your Covisint sales representative for details on
purchasing and enabling Auto-Loader for your organization.

The SFX Auto Loader provides a secure HTTPs mailbox to which batch transmissions of
files can be sent.

The Auto Loader processes received batch transmissions and parses them into individual
document files. The Auto Loader then places the individual files into their proper
destination folders so that only the intended recipients may access them.

How are the SFX Auto Loader file operations controlled? Before the Auto Loader is
placed into service, SFX administrators pre-configure both the sending (their customer
systems) and receiving (their Covisint SFX application) systems. View the sequence of
events required to configure and activate SFX Auto Loader.
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Sequence of Events

The following checklist provides a high-level overview of the process used to configure
and activate the SFX Auto Loader.

|

TASK

b

Your organization's SFX Administrator creates folders and sets access
controls to those folders

Upon completion of folder setup, the SFX Administrator exports a list of
folder names and details with the corresponding unique SFX folder paths

The Administrator then loads this list into their sending system.

The customer system sends files to Covisint tagged with a unique SFX folder
path for each file.

The Covisint messaging system routes the files into SFX where they are
parsed and routed into the appropriate folders.

(| [ Il B )

SFX end users are able to securely access files.
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Setting Up the Receiving System

SFX Administrators must configure their receiving system before they can use Auto
Loader. Before Administrators configure their receiving system, they must create folders
and establish folder access rights.

The following checklist provides a high-level overview of the process used to set up the
receiving system.

d TASK ADDITIONAL DETAILS
] Configuring the (Covisint task) Auto Loader functionality requires the
mailbox assignment of a secure (HTTPs) mailbox to an SFX

instance. A Covisint Administrator will configure and
assign the mailbox, at the customer's request. Covisint will
provide the customer with the information necessary to
transmit files. Customers will transmit files into their
HTTPs mailbox for Auto Loader processing.

] Creating (SFX Administrator task) Customers' SFX administrators
destination manually pre-create their folder structures in SFX before
folders sending XML batch transmissions to Covisint (see create

folders and administer access in SFX). Upon creation
customers can access folder details by generating a Folder
Details report.

] Processing files (System task) When customers send batch transmissions
of tagged files into their HTTPs mailbox, Auto Loader
processes them as follows:

e The system polls the mailbox every 15 minutes.

e When the system detects new transmissions, it
parses them into individual files, and writes each
file into the correct folder.

o Ifanew file (in a given folder) has the same name
as an existing file, the existing file is overwritten.

Note: SFX versions all files, so users can browse
and restore an overwritten file.

o If'the sender transmits files tagged with a folder
name or path that does NOT exist in SFX, the
folder is created and the files are loaded into the
newly created folder. Automatic folder creation is
denoted with a message of "Auto Created Folder"
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in the Status column of the File Processing Report.
e The maximum file size of any given batch
transmission is 10MB.
e The system supports the distribution of a single file
into multiple folders, if it is tagged appropriately.

] Reviewing the
file processing
reports

(SFX Administrator task) For each transmission and file
processing event, SFX creates a File Processing Report.
The reports are available to SFX Administrators to allow
for rapid visibility into Auto-Loader processing. They
allow administrators to validate, troubleshoot, and audit
file processing. The reports include:

e Date and time of transmission

e File name

e File path

o Transmission status (success/failure)
e Error messages (when applicable)

] Performing
error handling

(System task) In the event of a transmission or file
processing error, SFX:

e Logs the processing errors that occurred during file
processing.

e Allows administrators to activate or deactivate
email notifications through the SFX user interface.

] Delivering files
to end users

(System task) When users access the SFX application they
can view and download Auto Loaded files provided they
have been granted access by their SFX administrator.

SFX allows users to activate or deactivate email
notification on a file or folder. When notification is
enabled, SFX sends users email notifying them of new or
updated files.
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Setting Up the Sending System

SFX Administrators must configure their sending system before they can use Auto
Loader. Administrators configure their sending systems to tag each file with the SFX
destination folder path. SFX Administrators access the information required to tag their
files by generating and exporting a Folder Details report in SFX.

Before Administrators configure their receiving system, they must create folders and
establish folder access rights.

The following checklist provides a high-level overview of the process used to set up the
sending system.

d TASK ADDITIONAL DETAILS

] Generating the (SFX Administrator task) Exporting the results of the
Folder Details Folder Details report provides customers with the
report information they need to tag files prior to transmission to
Covisint. A customer SFX Administrator can access SFX
and then generate a Folder Details report. The report
includes:

e Folder name

e Folder description

e Folder keywords*

o Folder permissions (e.g. names of collaborators,
viewers, etc.)*

e Approval workflow status (e.g. enabled/disabled)

e Approver names

o Folder path

*To be implemented in a future release

] Exporting (SFX Administrator task) After generating Folder Details
reports reports, SFX Administrators can export them to their PCs
in CSV (Comma-Separated Values) format.
] Configuring (Perform this task in 'other' systems that will send files to

sending systems  Covisint) Customers use the data obtained in the Folder
Details report to configure their other systems to produce
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files tagged with the SFX destination folder path for
proper routing and delivery. Customers are responsible
for ensuring the appropriate identifier (path) tags are
applied to each file submitted.

Validating the (Perform this task in 'other' systems that will send files to

Covisint Covisint) Customer systems must send batch file

standard file transmissions in the Covisint standard XML format.

format Details are provided by the Covisint Administrator
assigned to your project.

Transmitting (Perform this task in 'other' systems that will send files to

files Covisint) Clients can use automated or manual means to

transmit files to Covisint via HTTPs.
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Generating a File Processing Report

This task can only be performed by an SFX Administrator, and only if
your organization has purchased Auto-Loader functionality.

1. Click the Admin menu and select Reports -> Auto Loader File Processing. The
report processing window displays.

Secure File Exchange

Folder Actions Iﬁl Help View: Al Documents
. Repository Setting
—— ‘_)@’ System Settings |SEErCi"I Documents
US SIZE TYPE MODIFIED DATE L
N .. 5o
April 19, 2011 12:586
[Z5] A_miketest_folder g User Disk Space Folder S g
Large Files April 18,2011 11:84 |
3l chris123 Fald
G chis [] Most Accessed Filg O amEDT
l] Auto Loader File March 11, 2011 D5:01
[Z5] christest Folder g
[] Folder Detimd Reps Lo

hdaw 77 NG N7T-RT

2. Inthe report processing window, configure the report you want to generate by
selecting options as required.

Secure File Exchange

Folder Actions | Admin  Help | [4)Back View: Al Documents
HOME = REPORTS : AUTO LOADER FILE PROCESSING REPORT
From Date To Date Status
earch
041312011 0412012011 |Select a Status ;l
Ref # Date Status ~ Message

a. Modify the From Date
b. Modify the To Date
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c. Select a Status

Status values are:

Success - all files transmitted successfully to the specified SFX
folders.

Partial Success - all files transmitted successfully to SFX.
However, some specified folders could not be located, so SFX
auto-created folders in which to place the transmitted files.

Failure - the transmission to SFX failed entirely.

If you do not modify the default selections for the options, the report will
include files of all statuses processed within the displayed date range.

3. Click Search.
4. Click Details from the File Processing report. The report details display.

Where is the Details link?

Secure File Exchange

(4]Back View: AllDocuments

Folder Actions | Admin | Help

HOME = REPORTS : AUTO LOADER FILE PROCESSING REPOR
From Date To Date Status

01022007 04/20/2011 | Select a Status LI
Status

Ref#

Search

July 18, 2008 10:09

AMEDT Failurs Message Receive Emorjavax.eml.xpath XPathExpr. . =
July 11, 2008 11:00 )

BulkTest Sucoess Filz successfully uploadad =
AMEDT
July 11, 2008 10:59

BulkTest Sucoess File sucoessfully uploaded Ci=
AMEDT

5. View report details as required. Click Back to return to the list and view another
report.
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Secure File Exchange

Folder Actions ~ Admin ~ Help

[4]Back View: AlDocuments

HOME > REPORTS : FILE PROCESSING DETAILS
Process Date: July 11, 2008 11:00 AM EDT

Message: File successfully uploaded
Reference Number: BulkTest

Status: Success

MHame Status Message
Q Dugplicatel.doc Sucoess File Added
Q Duplicate? doc Sucoess File Added

Location
IAutoload Test

fAutoload Test

RESULT:

You have successfully generated File Processing Report.
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Generating a Folder Details Report

This task can only be performed by an SFX Administrator, and only if
your organization has purchased Auto-Loader functionality.

1. Click the Admin menu and select Reports -> Folder Details Report. The folder
details report window displays.

Secure File Exchange

HOME

T eper

View: Al Documents

- Repository Setting

r&" Swstem Settings

[ZE A_miketest_folder

[Z3] chris123

[Z5] christest

[E5) CON_NEW1

us

Overview

isgll User Disk Space
Large Files

@ Most Accessed Filg
|2 Auto Loader File PY

| Folder Details Repd
$

SIZE TYPE MODIFIED DATE L

|Search Documents

April 19, 2011 12:55
Folder 4
PM EDT

April 18, 2011 11:54

March 11, 2011 05:01
AM EST

May 27, 2009 07:57
PM EDT

2. View the Folder Details Report as required.

Folder Details Report
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View: All Documents

Folder Actions | Admin | Help |

HOME = REPORTS : FOLDER DETAILS REPORT

Expor
View 1-20 of 126 « previous page:1 2 3 4 5 6 7 nexts 20 x| pery
Folder Approwval workflow
Folder Hame Folder description Folder path
pEMIissions status
A_miketest_folder = disable i#_miketest_folder
chris123 TESTING = disable Ichiis123
christest test = disable Ichristest
CON_NEW1 = disable JCON_MEW1
COL_MEW1 = disable JCON_NEW1/COL_NEW
JCON_MEW1/COL_NEW1/ddes
ddeed 2 sub ddeed 2 sub = dizable
sub

a. View details of any folder in the repository.
b. Hover over the Folder Permissions column to view user access details.

3. Click Export if you want to export the report in a CSV format file. A file

download dialog displays.

Where is the Export button?

Secure File Exchange

Folder Actions | Admin | Help

View: All Documents

HOME = REPORTS : FOLDER DETAILS REPORT

Expor
View 1-20 of 126 « previous page:1 2 2 4 56 7 nexts 20 v | pery

Folder Approwval workflow

Folder description Folder path
pEMMissions status

£_mikstest_folder = dissble J&_rmiketest_folder

chris123 TESTING = disable Ichiis123

christest test = disable Ichristest

CON_NEW1 = disable JCON_MEW1

COL_MEW1 = disable JCON_NEW1/COL_NEW
JCON_MEW1/COL_MEW1/dde]

ddead 2 sub ddead 2 sub = disable
sub
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4. Click Save and follow your PC prompts to save the CSV file.

RESULT:

You have successfully generated a Folder Details Report.
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